PowWow Navigator Window



PowWow Navigator
Welcome to PowWow, the world’s best Internet conferencing program.

The PowWow Navigator is the main PowWow window and handles all tasks except those which are available only from the Personal
Communicator window. Visually, the PowWow Navigator displays the Communities you have joined and lets you interact with other
Community participants in a general manner. (One-on-one communications require the Personal Communicator.)

Important: For help about a dialog, click its Help button. For help about a menu item, highlight (don’t click) the item and press
function key F1.

Important: Many PowWow menus and options are accessed by right-clicking a displayed entry, such as a Community name or a
user’s name.

PowWow User's Guide

The new PowWow User's Guide is an executable file named PWMANUAL.EXE. The presentation resembles a Web browser. If
you have a license to host a Community, you will want to refer to the Community Administration Supplement, which is in
PWHOST.EXE.

If you have installed this version over a previous one, all your settings were saved and you can proceed as usual.

If this is your first time running PowWow, you’re looking at a blank PowWow Navigator window. Since you got PowWow so you
could talk to other people, let’s get you up and running. Click an item in the following list for information and procedures:

How To...

Other Information
What the Symbols Mean

Buttons and Menus

Taskbar Buttons and Icons
Glossary

Text-to-Speech Abbreviations

Startup Switches

Contact Information
Support

About Tribal Voice



Joining a Community
To join a community, follow these steps:
1. Click the Communities button @ on the PowWow Navigator window.
2. Click the Join a Community option. [The PowWow Address Book displays]
. If there is an entry in the list, you can select it and click the Join button.
. If you know the address of the Community, you can enter it in the Address field and click the Join button.
. If you’re browsing for a Community, click the Online Community Guide button.
Your Internet browser will open to the Tribal Voice Communities page. This page lists numerous categories of
Communities. When you click a category, you’ll transfer to the web page which lists the Communities in that category.
For instance, if you’re a new user, you might want to select the PowWow category and then the New PowWow Users
Community entry (newusers@tribal.com).
Important: Click an entry only once and then close or minimize the Internet browser window.
When you have selected a Community:

e The Community Controls Information window displays basic information. Click OK.

. Most Communities also display a brief welcome message, which is cleared automatically unless you click the window’s Hold
button.

. The Community name and the names of active users are placed in the PowWow Navigator window: However, notice that you
won't see your own name in the listing.
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. The PowWow Group Chat window also opens, so you can view and join the conversations which are going on.

Note: If you have checked "Automatically save all connections to Address Book" in the Communities section of the Runtime
Options, the Community's address automatically will be placed on the Communities tab of your PowWow Address Book. This lets
you easily re-join this Community at a later time.




Open a Chat Window

To open a general Chat window so you can view and join in:

1. Right-click the Community’s name.
2. Select the Group Chat option.



View User Info

To view information about an online user, simply right-click the person’s name in the list. A menu is displayed, from which you
select one of the options. Click the menu option for more information.
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Buttons and Menus

The PowWow Navigator has several sets of buttons and menus: the Navigator button bar and the menus which are displayed
when you right-click:

A User's name

A Community name

The Buddies entry in the Navigator window and

The Recent Logins entry beneath a Community name
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For more information about each one, click each of the graphics, below.
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Navigator Button Bar

Down the right side of the PowWow window is a series of buttons. The small 4 on some buttons, such as Configuration, indicates
that selecting the button will display a menu. Click an icon for more information.
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& Buddy List
When you click the Buddy List button or right-click the Buddy List icon in the Navigator window, the following menu displays. Click
the applicable menu item for more information.

Buddy List |

=% Add Buddy...
¥ Online Uzer Listing
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& Add Buddy

Select this option to open a dialog which lets you enter a Buddy request to someone who may not be online. The request will be
forwarded to the person the next time he or she starts PowWow.

The information also is added to your Address Book.



ﬁ Online User Listing
Select this option to start your Internet browser and go to the Tribal Voice Search the White Pages page. There, you can look for a
particular PowWow user or for all PowWow users who share a common characteristic.



& Online Visibility
Note: These options only affect how you appear on someone else’s Buddy List. When you have joined a Community, you’re
always visible. You can’t “lurk” unseen.

Selecting this option opens another menu which lets you specify your status to people on whose Buddy Lists you appear. Click the
applicable menu item for more information.
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Online

This is the default Buddy List visibility option. It indicates to people on whose Buddy List you appear that you are online and
available.



Away

Select this visibility option to let people who have you on their Buddy List know that you are online but not currently available. This
option also turns on your Answering Machine if it is not already active.



Do Not Disturb

Select this visibility option to let people who have you on their Buddy List know that you are online but busy and would prefer not to
be disturbed. This option also turns on your Answering Machine if it is not already active.



Invisible

When you select this visibility option, your name will not appear on any Buddy Lists although you will be able to see people on your
Buddy List.



Offline

When you select this visibility option, your buddies cannot see you and your own Buddy List is deactivated.



Duplicated for better appearance when selected from Index



Online

To access this option, click the Buddy List button ﬁ on the Navigator window or right-click the Buddies entry in the Navigator
window.

This is the default Buddy List visibility option. It indicates to people on whose Buddy List you appear that you are online and
available.



Away

To access this option, click the Buddy List button ﬁ on the Navigator window or right-click the Buddies entry in the Navigator
window.

Select this visibility option to let people who have you on their Buddy List know that you are online but not currently available. This
option also turns on your Answering Machine if it is not already active.



Do Not Disturb

To access this option, click the Buddy List button ﬁ on the Navigator window or right-click the Buddies entry in the Navigator
window.

Select this visibility option to let people who have you on their Buddy List know that you are online but busy and would prefer not to
be disturbed. This option also turns on your Answering Machine if it is not already active.



Invisible

To access this option, click the Buddy List button ﬁ on the Navigator window or right-click the Buddies entry in the Navigator
window.

When you select this visibility option, your name will not appear on any Buddy Lists although you will be able to see people on your
Buddy List.



Offline

To access this option, click the Buddy List button ﬁ on the Navigator window or right-click the Buddies entry in the Navigator
window.

When you select this visibility option, your buddies cannot see you and your own Buddy List is deactivated.



@ Communities
When you click the Communities button, the following menu displays.

@ Join a Commurity
m Hoszt *r'our Own Community
@ Online Community Guide

Click the applicable menu item for more information.
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ﬁ Host Your Own Community
If you are licensed to host a Community, you can start and host your own Community. Note: This Community will be available
only while you are connected to the Internet and running PowWow.

If you do not yet have a license and would like more information, please send e-mail to sales@tribal.com or visit our Web site at
http://www.tribal.com/.



Host Your Own Community

Get My License

If you have not yet purchased your license to host a Community, you can place your order online by clicking this button. When you
do, the Web browser you configured in Preferences => Web Browser will start and open the necessary form which you can fill in and
submit.

Have My License
If you already have a license to host one or more Communities, click this button to open the Community Host Information dialog.



Community Server Start
You can start a Moderated or an Unmoderated Community.

If you start a Moderated Community, the chat window will have a separate area which will display all your messages.

An Unmoderated Community does not have a separate message area for the host. The New Users Community is an example of
an Unmoderated Community.



Start My Community

Use this dialog to set up the required host information and to start your Community.

Community PowWow Address

This is the PowWow address of a configured user. If you have added multiple users to your account, you can select which user will

be the host.

Note: The Community PowWow Address should be a valid e-mail address.

Important: This address:

1. Possibly should not be the same as your normal PowWow Address. If the only address is your address and you never
expect to log into PowWow from another location, go ahead and use your own address. But, if the only address is your
address and you do expect to log into PowWow from another location, click the Add Community PowWow Address button to
create a new User/Community identity.

2. Must be unique for each Community you host.

Please click here for an explanation of the Community Pow\Wow Address restrictions.

PowWow Password
This is the password of the selected Community Address (user). This password was set up when the User was created. The
password is displayed as asterisks.

Community's Name

If the selected address already has a Real Name/Handle associated with it via the Preferences => User Info tab, that name will be
placed in this field by default. You can change this to any Community Name you like and it will appear in this field until you change
it.

PowWow Owner Address
When you purchased a license to host one or more Communities, this is the PowWow Address you supplied. This must be the
address you use for all the Communities you run.

Important: If this address also is set up as a User, you will not have to supply a password when you click Launch My Community.
Otherwise, you will have to enter the password associated with this address each time you start a Community.

Add Community PowWow Address
Click this button to launch the Add New User wizard to create a new Community PowWow Address. You would want to do this if
your normal PowWow Address were the only one available to use as a Community Address.

Community Administration
Click this button to open the Community Administration dialogs, which are explained in the next section. Note: When you exit the
Community Administration dialogs, the Community is launched automatically.

Start My Community Now
Click this button to start this Community. PowWow will verify that the Owner's PowWow Address is licensed to host one or more
Communities and then will present the Password Entry dialog, if necessary.

When your Community starts, it will appear in the PowWow Navigator window along with any other Communities you may have
joined.

Administer the Community
To change the Community's parameters, right-click the Community's name and select the Administrate option.

Important: To close your Community, right-click on the name and select Exit Community.



Community PowWow Address

For any Community you host to function correctly, please be aware of these two important restrictions on the Community PowWow
Address:

1.

Do Not Use Your Normal PowWow Address If ...

... you expect to log into PowWow simultaneously from multiple locations. You should create a unique User which will be
used only to host a Community. If you start a Community using your normal PowWow Address and then log in from a different
computer, the registration server will update the IP address which is associated with the PowWow Address. In effect, your
Community will no longer exist and people will not be able to join it.

Example:

Fred's PowWow Address is fred@isp8468.net and he hosts a Community with the same address. Since both Fred and his
Community are running on the same machine, both will have the same IP address. When a person wants to contact Fred or
join his Community, the message is sent to the PowWow Server which translates the isp8468 portion of Fred's address to the
numerical IP address equivalent (such as 123.45.67.890) and then forwards the message to the correct machine.

This doesn't cause any confusion because incoming messages include header information which Fred's PowWow program
uses to route the messages either to Fred as a person or to Fred's Community.

With his Community up and running, Fred goes to a friend's house to admire her new computer setup. While there, he
downloads and installs PowWow and logs in using his normal PowWow Address -- fred@isp8468.net. The PowWow
Server notices that Fred has moved to a new physical location and updates his IP address.

Anyone wanting to contact Fred still can do so because their messages are routed to the correct machine.

However, requests to join Fred's Community also are routed to the new location. PowWow receives these messages and
checks to see what Communities it is running at the current location. Since Fred's Community is not running at the current
location, PowWow reports that the Community is not active and Fred starts getting messages asking why his Community isn't
in operation.

Use A Unique Address for Each Community

If you host multiple Communities from the same computer, the part of the Community Address which appears before the "@"
sign must be unique.

Example:

John and Mary are racing fans who share a computer and therefore the same IP address. John hosts a Community named
Racing@isp1984.com for people interested in stock car racing; Mary hosts a Community named Racing@isp1066.com for
people interested in drag racing. Mary, an early riser, happens to start her Community first.

Later in the day, a stock car racing fan decides to join John's Community. The request goes to the PowWow lookup server
which:

. Finds the listing for Racing@isp1984.com,
. Resolves the address (Racing@isp1984.com) to the correct IP (machine) address (Racing@123.45.67.890) and
. Directs the fan's call to that address.

Arriving at the correct physical machine, the request looks through the list of active Community names, finds the listing for
Racing and joins that Community. Unfortunately, it's Mary's drag racing Community. It was started first, so it appears first on
the local list.

In other words, if multiple Communities share the same name on the same machine, callers will join whichever Community of
that name was started first.



ﬁ Online Community Guide
Select this option to start your browser and open the Communities page at the Tribal Voice web site. Here, you can select among
the types of communities available and then select a community to join.



& Exit All Communities

Select this option to exit all the Communities to which you’re attached. This does not close PowWow.



Exit PowWow
Select this option (click the [X] button on the PowWow Navigator window) to close all connections and exit PowWow.
It may still show up as a task under Task Manager for 30 seconds or slightly more. This allows PowWow to write any unsaved

information to disk (address book changes, information about the positions, colors, and fonts of any windows, notifying the Buddy
Server you’re no longer online, and so forth).



o

H Personal Communicator
When you click the Personal Communicator button, it toggles the display of the Personal Communicator window. This setting is
saved so that, if the Personal Communicator window is toggled to On, the next time you start PowWow, the Personal Communicator
window will open automatically.



& World Wide Web

Note: These options also are available from the Personal Communicator.

When you click the World Wide Web button, the following menu displays. Click the applicable menu item for more information.

World Wide Web |

= Send Povtw/ow to a Friend...

White Pages ¥
Becent Powiwow Logins k
Online Community Guide

Dawrload Latest Powtafow Releasze

e @ () b

Tribal Woice Homepage




A Address Book

Note: These options also are available from the Personal Communicator.

When you click the Address Book button, the following menu displays.

Address Book

T Address Book...
SJ Erequent Outgoing Pages *
% Becent Incoming Pages  #

Click the applicable menu item for more information.




f Answering Machine
Note: These options also are available from the Personal Communicator.

When you click the Answering Machine button, the following menu displays.

Answering Machine

& Answering Machine On
J%a Wiew Snswering Machine

Click the applicable menu item for more information.




h Configuration

Note: These options also are available from the Personal Communicator.
When you click the Configuration button, the following menu displays.

'\. Preferences. .

Click the applicable menu item for more information.
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=& On Top
When you click the On Top button, it toggles whether or not the PowWow window remains displayed on top when you switch to
another window.



« Help
Click this button to display the Help menu.



Cue Cards

Click this button to display the Cue Cards. These cards provide step-by-step procedures to accomplish the more commonly-used
tasks, such as connecting to Communities and people, and configuring PowWow.



Send an Insta-Voice Message
An Insta-Message is a voice message which you send to an individual. To do so:

1. Right-click the person’s name in the Community listing.
2. Select the Insta-Voice Message option.

A dialog opens in which you can record, review and send your voice message.



Send an Instant Message
An Instant Message is a text message which you send to an individual. To do so:

1. Right-click the person’s name in the Community listing.
2. Select the Instant Message option.

A dialog opens in which you can compose, review and send your text message.

Important: If you send an Instant Message to someone from your Buddy List when you are not on that person's Buddy List, your
message is sent directly to that person's Answering Machine.

When you send an Instant Message to a person in a Community list, a flashing blue icon appears by your name and your name
is moved to the top of the list to alert the recipient. But if you send from your Buddy List to someone on whose Buddy List you
don't appear, there is no way to signal that he or she has received an Instant Message from you. Therefore, the message

goes to the person's Answering Machine and the Answering Machine button flashes a blue icon .

See also: Receiving an Instant Message




Receiving an Instant Message
Receiving a URL Message
When you receive an Instant Message (a text message sent directly to you from another online user) or a URL message, you’ll hear

the alert signal (which is played by the MESSAGE.WAV file and which defaults to a barking sound), the name of the person who
sent the message will move to the top of the Community listing and a small blue “letter” icon will blink by the name, such as:
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Close
This option simply closes the message window. The message is not deleted and the message indicator icon continues to blink by
the sender's name. You can double-click the name to reopen the Instant Message display window.

Saving the Message
Important: If you exit PowWow, any Instant Messages which were not Removed are moved to your Answering Machine file and
saved.

PowWow
Click this button to send a chat request to the message sender.

Reply
Click this button to send an Instant Message reply to the message sender.

Open URL
This button is present if this is a URL message. Click this button to open your Web browser (if necessary) and open the URL you
were sent.

Previous
If you have received multiple Instant Messages, you can click this button to re-read a previous message.

Next
If you have received multiple Instant Messages, you can click this button to read the next message.

Remove
Click this button to delete the displayed Instant Message. When you exit PowWow, this message will not be saved to your
Answering Machine.



Request a PowWow

A PowWow is a personal chat session which uses the Personal Communicator window instead of the general Group Chat window.
You can have personal chats with up to eight people at a time — your Personal Communicator window will divide itself into up to
eight panes; each having its own set of controls.

There are at least five ways to request a personal chat with someone:

Method 1
1. Right-click on the name in the PowWow Navigator window.

A menu is displayed.
2. Select the PowWow option.

Method 2
1. Double-click on the name in the PowWow Navigator window.

Method 3

1. Click the Address Book icon %

2. Select the Address Book option. The Address Book opens to the Users tab.
3. Click a name in the list.

4. Click the PowWow button.

Method 4

1. Click the Address Book icon.

2. Select the Address Book option. The Address Book opens to the Users tab.
3. Enter a PowWow address in the Request to Chat section.
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4.  Click the PowWow button.

Method 5

1.  Click the Address Book icon.

2. Select either the Frequent Outgoing Pages or Recent Incoming Pages option.
3. Click a listed PowWow address.

What Happens

. The request is sent to the selected person.

. A Request a PowWow message is displayed on the person’s monitor.

. The person can accept or reject the PowWow request or the request can time-out if the recipient does not respond in time
(approximately 20 seconds) or the recipient may not be online.

Note: If the chat request is accepted and if you have checked "Automatically save all connections to Address Book" in the
Personal Communicator section of the Runtime Options, the person's PowWow address automatically will be placed on the
Users tab of your PowWow Address Book. This lets you easily page this person at a later time.

. If your request is accepted, the Personal Communicator window opens (if necessary) or a pane opens.
. In the other cases, you will be able to leave a message on the person's Answering Machine.

See also: Receiving a PowWow Request.




Receiving a PowWow Request
When someone sends you a PowWow request, a message, similar to the following, will be displayed:
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If you select Accept and click OK, a pane for the person will open in your Personal Communicator window and you can converse
directly.

Note: If you have checked "Automatically save all connections to Address Book" in the Personal Communicator section of the
Runtime Options, the person's PowWow address automatically will be placed on the Users tab of your PowWow Address Book.
This lets you easily page this person at a later time.

Important:
If:
. your Answering Machine is on, or

. you do not reply within 20 seconds and the Chat Request dialog times out, the sender will see this dialog:
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The sender can leave a message which will be routed to your Answering Machine.

If:
. you selects No, or
e  you are not online, the sender will see this dialog:
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He or she can enter a message which will be routed to your Answering Machine.

If:
e youselectNo, with reason, the sender will receive a message similar to:
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The sender will be able to leave a message which will be routed to your Answering Machine.



What the Symbols Mean

The symbols by the name of a Community or a PowWow user provide the following information:

@ The blue C-and-World indicates that this is a normal Community of which you are a member.

@ The yellow C-and-World indicates that this is a Community you have started.

ﬁ The orange icon indicates a standard entry.

V%{t L tThe green icon indicates that a person on your Buddy List is online and available or that the person is on the Community
atch List.

The orange icon with the red "x" indicates someone who is on your Buddy List who does not wish to be disturbed.
The yellow icon indicates someone who is on your Buddy List who is away from his or her computer.
The gray icon indicates a person who is on your Buddy List but who is offline.

The orange icon with the gold star indicates the person is a PowWow Guide who has passed the exam.
The question mark indicates you have sent the person a Buddy Request to which the person has not yet replied.

3.@% I T e

The blue "M" indicates that the person is the Moderator or Guest Moderator of this Community.



Startup Switches

There are two command-line switches you can use to modify PowWow's startup procedure:
Start As Specified User

If you have configured PowWow with more than one user, you can create a desktop shortcut icon which starts PowWow using a
particular user's settings. (For information about multiple users, refer to Add a New User in the Configuration Menu.)

To do so:

1. Create a shortcut to the PowWow application. (Right-click POWWOW32.EXE and select the Create Shortcut option.)

2. Right-click the new shortcut and select Properties.

3. Select the Shortcut tab.

4. Edit the Target field by adding the /L switch (you can use upper-case or lower-case) followed by the PowWow Address of the

user, such as /L pwtestl@tribal.com. The field will appear similar to:

Targel type: Application
Targel location Pawiwiowd2
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5.  Click the OK button.
Start and Immediately Page Someone

Use this command line option to start PowWow and send an immediate page to a specified user. To do so:

1. Create a shortcut to the PowWow application. (Right-click POWWOW32.EXE and select the Create Shortcut option.)

2. Right-click the new shortcut and select Properties.

3. Select the Shortcut tab.

4. Edit the Target field by adding the PowWow Address of the user, such as pwtestl@tribal.com. The field will appear
similar to:

Tanpat tppe: Applcation

Tagetlocation:  PowiwWowd2

Tawpet: Inw’#nw&ﬂ%w’#uw&?.exa"|:l.we3l1 @irbal.com

5. Click the OK button.

Until you change the startup settings, when you start PowWow, the Navigator window opens. When you join a Community, the
Group Chat window opens, and when you establish a PowWow, the Personal Communicator window opens. You can resize each
window so you can see all three and easily move around as needed.



Taskbar Buttons and Icons
When PowWow is running, these icons and buttons will appear on your Taskbar:

Fersonal Active Mavigatar
Cuynicatnr Cammunity [can

i Perso... | (@ Paw... T TG 2 f{'_ 10:53 AM

When you right-click the Navigator icon, this menu is displayed:
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Exit PowWow
Select this option to exit Pow\Wow.

Online Visibility
Please refer to the Online Visibility description in the Buddy List Menu section.

Open PowWow

If the PowWow Navigator has been minimized or is in the background, select this option to maximize it or return it to the foreground.
(You also can double-click the icon.)



System Requirements

PowWow will run on a system meeting the minimum requirements of the operating system: Windows 95 or Windows NT version
4.0. For full functionality, other hardware, such as a sound card, is required. The following lists the general minimum system
requirements. As always, the more power you have available, the smoother everything will run.

Processor: Intel 80486DX-33 compatible or faster.
Operating System: Microsoft Windows 95, Windows 98 or Windows NT 4.0 or higher.

Internet Connection: PowWow requires a TCP/IP (Internet) connection running at 9,600bps. To use voice, a modem connection
of at least 14,400bps is required.

E-mail: To use the Send and Receive E-mail functions (refer to Appendix A: Preferences), PowWow requires an e-mail server
which uses the standard POP3 and SMTP mail protocols. Important: AOL.COM, JUNO.COM, HOTMAIL.COM, KKTV Freemail
(KKTV.COM), BIGFOOT.COM, MAILCITY.COM, MAILEXCITE.COM, ROCKETMAIL.COM, TRAVELTALES.COM and Microsoft
Network (MSN.COM) do not use the standard POP3 or SMTP mail protocols. You will not be able to send e-mail to, or receive e-
mail from, these services.

Web browser: A World-Wide Web browser is required for cruising the web together and for viewing PowWow White Pages.
Compatible Web browsers include: Attachmate Emissary 2.0 beta 3 or later; Netscape Navigator 1.1N or later; Microsoft Internet
Explorer for Windows 95 Version 2.0 and 3.01 or later; Softronics Softerm browser 4.00.08 or later. Note: PowWow is not
compatible with America Online’s proprietary browser. See Appendix C: Using PowWow with America Online, for instructions on
how to use PowWow from AOL.

Please note the developers' and preview releases of Internet Explorer did not work correctly with PowWow. There also are reports
that Internet Explorer 4.0 version 4.72.2106.8 with a Cipher Strength of 40-bit also does not work correctly. You can check which
version you have by clicking on About Internet Explorer from the menu.

Sound Card: A Microsoft Windows-compatible sound card is required for voice communications, using the Text-to-Voice feature or
playing .WAV sounds.



Alert Log

When you double-click the bottom of the frame of any of the three main windows (Navigator, Personal Community and Group Chat),
an Alert Log is displayed. This simply lists the last events which have been processed by PowWow:

Alwil Log E

Altermnphing bo registes wath Powiifow server. Waling foniesponse
duliemmpling bo regisied wilh Posis’oss buddy server. Waling lo iesponss,
idress lnotoup requessted Waiting for 1esponse:

Lok request succeeded, Contachng host

Fiegsiration accephed by Poswow Buddy Serves

Fisguirasbion sccepled by Posiaow server.




Enter Password
Please enter the password (which is case-sensitive) for the active User or Community.

This dialog is displayed if:

1. The Save Password checkbox is not checked in Preferences=>User Info or
2. The PowWow Owner Address (on the Start My Community dialog) is not configured as a User.




Mail Password
Please enter the e-mail password (which is case-sensitive) for the active User.

This dialog is displayed if:
. The Save Password checkbox is not checked in Preferences=>Mail Send/Receive.

If you do not require this security check, you can check the Save Password box. This is equivalent to checking the Save Password
box in Preferences=>Mail Send/Receive.



ﬁ Cue Cards

Click this button to display the Cue Cards. These cards guide you through some of the more frequently-needed procedures, such
as connecting to a Community or a person and configuring PowWow.



Using the Cue Cards

Cue Cards walk you through the steps to accomplish frequently-used tasks, such as joining a Community, paging a person and

configuring PowWow. When you select one of the link options, a series of windows lets you choose and follow the steps you want
to perform.

Note: Cue Cards default to always appearing on top of all other windows. To let the Cue Cards act like normal windows, click the
pin button & in the upper right corner so it looks like

ﬂ. To remove the Cue Cards window, click the Close button
X



Send E-mail Message

This dialog is displayed when you send an Instant Message to a Buddy who is offline ﬁ This message will be sent to the
person's e-mail address.

Note: You must have a valid SMTP e-mail account to use this function. For more information, please refer to Preferences: Mail
Send / Receive.

Make message accessible to recipient's PowWow Answering Machine

If this box is checked, PowWow will check the recipient's normal e-mail server for a message with a subject of PowiWow®
Answering Machine Message and retrieve this message into the PowWow Answering Machine. Note: If the recipient first
checks his or her e-mail using a normal e-mail program, this message will be retrieved by the program and will not be available to
PowWow.

If this box is not checked, you can change the Subject, and PowWow will not find it when it checks the recipient's mailbox. For
more information, please refer to the Enable PowWow to Receive E-mail section of Preferences: Mail Send / Receive.

Recipient's Email Address
This field defaults to the person's PowWow Address. If this is incorrect, enter the correct information.

Subject

This field defaults to PowWow© Answering Machine Message and cannot be changed unless you uncheck the "Make
message accessible ..." box, above. If the recipient checks e-mail, using his or her normal e-mail application, before starting
PowWow, this is the subject he or she will see when the message is retrieved.

Message
Enter your message here. When completed, click the Send button.



Group Chat window



Group Chat Window

The Group Chat window is where you interact with other Community members. You can chat, play games, and read and write
messages here.

Alert Log
When you double-click the bottom of the frame, a log of recent events is displayed, similar to that shown by the Navigator window.

Your Text Entry Area

When you want to participate in the discussion, enter your comments in the top window pane. To transmit your comments to the
Community, press Enter or the Send button. Press Clear to erase your comments before you transmit them.

Moderator Display Area

If this is a Moderated Community, the Moderator's remarks are displayed in an upper pane separate from the normal visitors display
area.

Visitors Display Area

The Visitors area displays what participants transmit. Depending on their color selections and your color selections, the text may
appear in various colors. Please refer to the description of Colors in Preferences=>Runtime Options.

You can scroll back to view previous data, although the amount that is saved in the buffer is determined by the Buffer Sizes setting
in Preferences=>Runtime Options.

Cruise Switch
If this is a Moderated Community, the Moderator's window will have the Cruise button. He or she can click this switch to start the
Internet browsers on Community participants' computers and lead people on a tour of the World Wide Web.

Logging
You can save (log) all the typed activity in a Community. To toggle conversation logging on and off, click the Logging switch.
Note: Logging conversations for busy Communities can use up disk space quickly.

When you select the Logging option, you'll be able to name the log file. These files default to having a .CLG extension. e.g.:
MYLOG.CLG. These are plain text files which can be viewed by any word processing program or editor, including WordPad and
NotePad, which are supplied with Microsoft Windows.

Hear

To toggle the speech synthesizer on and off, click the Hear switch. An H will appear by everyone’s name in the Community Display
window, signifying that you can hear what they type. Note: PowWow's text-to-speech converter understands certain
abbreviations which you can type and which will be spoken correctly. Click here to see the list of abbreviations.

Games
Click the Games button to see a list of current games or to start your own game. Games you start can be joined or viewed by other
people logged into the Community.

Bulletin Board
Click the Bulletin Board button to read and write messages in the Community’s long-standing threaded-discussion message area.

Guest Book
Click this button to access the Community’s Guest Book, where you can review information other visitors have left and add your
own.



Bulletin Board

Use the bulletin board to read and write messages in a Community. To access the bulletin board, either:

1. Click the Bulletin Board button on the Community window, or
2. Right-click the Community name and select the Bulletin Board option.

Reading Messages Viewing Headers Creating Messages Administration

Reading Messages

Read the first message in the Bulletin Board.
Read the last message in the Bulletin Board.
Read the next message.

Read the previous message.

Read the next message in the thread (topic).

Read the previous message in the thread (topic).

"EEB R LD

To read a message by its number, enter the number in the Get Message by Number field and click the Retrieve button.

Viewing Headers

@ Retrieve and view the first 25 message headers (topics)

=¥ Retrieve and view the next twenty-five message headers.

Creating Messages
N
Create a new message.

RE|
Reply to the currently-selected message.

M Administration

When you are the Community moderator, you can:
. & Delete messages
. Set the maximum number of messages which can be placed on the Bulletin Board

When you select the Administration menu or the Administration button, a new dialog is displayed.






Bulletin Board Administration

Max # of Messages
Messages are stored on your computer. Here you can set the maximum number of messages allowed to be posted. (Since
messages really aren’t that big, disk space probably is not a real issue.)

Delete Message Number
Enter the number of the message you want to delete. Click the Delete Msg button to delete the message(s).

Check to Delete all Messages less than
If you check this box, all lower-numbered messages also will be deleted. This is a quick way to delete blocks of old
messages.



Post Message/ Reply to Message

Subject
If you're posting an original message, enter a subject in this field.

If you're replying to a message, this field will contain the current subject. You can change this.

Message
Enter the text of your message in this field.

Reply to Message Number
If you're replying to a message, that message number will appear in this field.

If you're posting an original message, you should leave this box unchecked and this field empty.

Private Message to

You can post a message which will be seen only by the person whose PowWow Address is entered in this field. The message still
goes to the Community Bulletin Board, but will not show up on any other user's list. Note, however, that the Community host has
full access to all messages, private or not.



Preferences Dialogs



Preferences: User Info
The User Info tab is where you enter your name, PowWow (e-mail) address, and password.

Real Name/Handle
Enter the name you wish other people to see and call you. You can change this at any time. For instance, if you find that you're
the ninth John in the Community, you can rename yourself.

PowWow Address
You should enter your e-mail address. If you do not enter a valid e-mail address, not all PowWow functions, such as the Answering
Machine, will work correctly.

Important: This address should not be used simultaneously from two locations. (For instance, one family member logs into
PowWow from one location and then another family member uses the same PowWow Address to log in from home.) The IP
address associated with the PowWow Address will be updated automatically and all messages will go to the last location which
logged on to the PowWow server.

Password
Enter the password you want to use to register your copy of PowWow. Passwords must be:

. No longer than seven (7) characters

e Contain only alphanumeric characters (a-z, A-Z, 0-9). Using any other characters, such as @#$%"&*"?+, etc., will result in an
invalid password.

Important: Passwords are case-sensitive. eg: ‘“abcdef” is not the same as “AbcdeF”. Please be sure to remember your
password.

If you enter the wrong password, you will see one or both of these messages:
The password you have entered does not match the one stored on the PowWow Buddy Server for
your PowWow address. Go to http://www.tribal.com/password.htm if you need further

assistance.

In this case, you can still use PowWow, but your buddies will not be notified when you're online.

The password you have entered does not match the one you first used to register PowWow. Go
to http://www.tribal.com/password.htm if you need further assistance.

In this case, you cannot join a Community and you cannot PowWow a person using his or her PowWow Address. To PowWow a
person, you must:

1. Use the PowWow option from the Users tab in the Address Book.

2. Use the person's correct IP address (such as 123.45.67.89).

3. 3. Select the Direct Connect option.

When in Personal Communicator mode, your name will be preceded by an asterisk (*).

To correct this problem:

. Exit PowWow.
. Restart PowWow.
. Carefully re-enter your password, paying attention to spelling, capitalization and number of characters.

If these measures do not work, go to the Web site specified in the error messages and complete the online form. The problem will
be corrected in no more than three working days.



Preferences: Personal Profile

Information entered here is what others can access when they right-click your name in the PowWow Navigator window and select
the Personal Profile, View Picture and View Homepage options.

In addition to biographical-type information, you can enter the URL of your home page (if you have one) and the location of a small
(10,240 bytes or less, JPEG-compressed) picture of yourself for other people to see. Note: JPEG is the only graphics format
supported by PowWow. If you specify a non-JPEG file, it will not display.



Preferences: Sound / Voice
You can control how your computer plays and receives sound files and adjust your voice chat quality.

Sound Settings
These settings apply to communications in the Personal Communicator.

Play Sounds
If this option is checked, others can use QuikSound to play .WAV files on your computer. If this option is not checked, you will
not be able to receive QuikSound .WAV sounds from others.

Transmitted Sounds
This setting only affects three of the sounds which can be sent using Quick Sound: Bye, Cool and Hi.

Voice Settings
These settings affect your spoken communications.

Allow Others to Send Me Voice Mail Messages
When this option is checked, others can send you Insta-Voice messages. These are messages which are recorded and then
transmitted to you.

Use Full-Duplex
If your sound card supports this mode, you can conduct real-time conversations just as you would using a telephone. That is,
both people can speak at the same time.

If this option is not checked, real-time conversations will be conducted in a CB radio-like mode. That is, only one person at a
time can talk.

Resolution
If your connections are fast and clear, you can use High Resolution. The sound data is compressed less, which results in
clearer speech.

If your connections are not that good, you should select Low Resolution. The sound data is compressed more so it takes less
time to transmit. However, some quality is lost in the compression.

To adjust your speech synthesizer settings, use the Text-to-Speech tab.



Preferences: Text-To-Speech

PowWow can synthesize all received text in the Group Chat and Personal Communicator windows and play it as speech. Here,
you can adjust the speed and pitch of the built-in speech synthesizer, set it to automatically start when you run PowWow, and install
additional voice fonts.

Important: If PowWow cannot find the voice file (see Add New Fonts below) or if the file has become damaged, the text-to-speech
function will not work. Make sure the Windows Registry setting (see Possible Error Message below) is pointing to a directory which
contains the necessary file. If the file has become damaged or missing, you may need to re-install PowWow to get an undamaged
copy of the TTS file.

Add New Fonts / Changing the Voice

The default voice, English Male, is supplied by the file EM32_1K8.DLL in the directory in which you installed PowWow. You can
change this to the English Female voice by clicking Add New Fonts and selecting EF32_1K8.DLL. If you obtain other voice fonts,
you would install them the same way.

Changing the Voice Characteristics

To change the speed and pitch, move your pointer to an area of the grid and click once. The green marker will move to the point
and a speech sample will be played. In general, a slightly slower speed and lower pitch is more understandable. However, if you
want the speech to keep up with the traffic in a busy Community, you may want to increase the speed.

Abbreviations

The Text-to-Speech engine also understands certain abbreviations. For instance, if someone types AFAIK, the speech engine will
render it as "As Far As | Know." Please click here or see Appendix G: Text-to-Speech Abbreviations, in the User's Manual
(PWMANUAL.EXE) for the complete list.

Possible Error Message
You may receive the following message:

Text to Speech is not enabled, either because you don’t have a sound card or Text to Speech is
improperly installed.

If so, before you re-install PowWow, you might check your Windows 95 / 98 / NT Registry settings.

Important: You should access and modify your Registry settings only if you are very familiar with the process. Mistakes can
cause your computer to fail.

1. Open the Registry.
2. Expand the HKEY LOCAL MACHINE section.
3. Expand the Software section.
4. Expand the FirstByte section.
5. Expand the Provoice and SpeechFonts sections and make sure both have PATH entries which appear similar to (but which
reflect your setup):
=-_1 FirstByte ] | Mame | Data
B33 Provoice 2B Defaul [value not sel]
=1 SpeechFonts PATH "c:\program fileshtribal voice\povaom 32"

----- 0 EM32_1K8




Preferences: Mail Send / Receive
If you would like PowWow to be able to send and receive mail, you’ll need to complete this information.

Hint: If you have an active e-mail account, you should be able to find all the necessary information by checking the settings used
by your e-mail program.

Important: AOL.COM, JUNO.COM, HOTMAIL.COM, KKTV Freemail (KKTV.COM), BIGFOOT.COM, MAILCITY.COM,

MAILEXCITE.COM, ROCKETMAIL.COM, TRAVELTALES.COM and Microsoft Network (MSN.COM) do not use the standard POP3
or SMTP mail protocols. You will not be able to send e-mail to, or receive e-mail from, these services.

E-mail
Your E-mail Address

Please enter the same e-mail address you use with your normal e-mail service, in the form
username@enterthedomain.com.

E-mail Password
This is the password you use to log into your e-mail account. This is not your PowWow password.

Keep Password
Check this to avoid having to enter your password every time you use mail.

Mail Servers
Enable PowWow to Receive E-mail
If you check this option, when you start PowWow, it automatically will attempt to log on to your e-mail server and retrieve
Answering Machine messages. These messages have the following Subject line:

PowWow (c) Answering Machine Message

After it retrieves the special Answering Machine messages, PowWow deletes them from your e-mail server. If you start your
normal e-mail program before you start PowWow, you will see these.

Receiving Mail Server (POP3)
If your e-mail address is freddie@enterthedomain.com, this entry generally will resemble mail.enterthedomain.com.

Enable PowWow to Send E-mail
Check this option to:

. Send Answering Machine messages via e-mail to users who are offline.
. Enable the Send PowWow to a Friend option.

Sending Mail Server (SMTP)
In general, this will be the same value you entered in the Receiving Mail Server (POP3) field.



Preferences: PULS / Tribe

Enter the URL’s (addresses) for additional PULS and Tribe servers. Most people will leave these blank unless their system
administrator has given them an address to use.



Preferences: Runtime Options
The Runtime Options allow you to set the defaults for request responses and window buffer sizes.

Personal Communicator Options
Each type of request (chat, file transfer, cruise, voice, and buddy) can be set to either prompt you when the request is received or to

automatically refuse the request.

Buffer Sizes (Kbytes)

This option controls how much text from a conversation is kept in memory and has no effect on the speed or quality of your Internet
connection or other options within PowWow. The buffer sizes let you set the size of the review (history) buffer in kilobytes (KB) for
each text entry and display area, provided your system has enough memory to accommodate your requested size buffer.

Self
This sets the size of the buffer which holds the text you enter in the Personal Communicator window.

Others
This sets the size of the buffer for every display window you have open. This includes all Personal Communicator panes other

than yours and all Group Chat windows.

Example: [f you were talking to two other people in the Personal Communicator and had three Group Chat windows open,
you would have a total of six message areas open (Self plus five Others). If Self and Others were set to 8 Kbytes, you would
have a total buffer size of 48 Kbytes.

Allow Colors

When this option is checked, you can set the foreground and background colors of your Personal Communicator window. When
you are chatting with someone, these are the colors which will be displayed in the Personal Communicator pane in which you are
displayed. In other words, if you have set your foreground and background colors to green on magenta, your text entry section of
your Personal Communicator window will be green on magenta, and you will appear in a green on magenta pane in the other
person's Personal Communicator window.

If this option is turned off (not checked), all text in the Personal Communicator and Group Chat windows and your pane in someone
else's Personal Communicator window will be displayed as your selected foreground color on a white background. Note that you
can change your text color in the Group Chat window by selecting the Text=>Change Color option in that window.

The following shows how each person's settings appear to others in the Personal Communicator window:
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Font
This is an internal PowWow setting which affects only PowWow displays.

When you click the Font button on the Preferences: Runtime Options tab, this screen is displayed:
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You can set PowWow display text to appear in any of the fixed-width (non-proportional) fonts installed on your system. The
generally-available fixed fonts are Courier, Courier New, Fixedsys and Terminal.

Automatically save all connections to Address Book

When this box is checked, the PowWow address of anyone with whom you have chatted will be saved to the Users tab of your
PowWow Address Book.  This lets you easily page anyone with whom you already have chatted. Note that the addresses of
people whose chat requests you have refused or ignored will not be written to your Address Book.

Community Options

Follow Moderator's Links
Check this option if you want to follow a leader on a "cruise" of the Internet. That is, when the cruise leader launches his or
her Internet browser, your browser also will launch and will go to the same destinations as the leader's.

Show Colors in Chat Window

People can select in which color they want their text to appear (setting the foreground color using the color bar in the Personal
Communicator window). When this option is checked, their text will appear in their chosen color in your Group Chat window.
If this option is not checked, all text will appear in the foreground color you have set on a white background.

Automatically save all connections to Address Book
When this box is checked, the address of any Community you have joined will be saved to the Communities tab of your
PowWow Address Book. This lets you easily rejoin a Community you like.

Special Video Card Settings
This option displays the Video Setup window. If you see error messages about your video drivers when using the Whiteboard or
connecting to other users, click this button.

To speed up the video display, you can turn off the features PowWow uses. By default, advanced graphics features are enabled.



Video Setup

If you see error messages about your video drivers when using the Whiteboard or connecting to other users, check the Disable
Advanced Graphics box and click on OK.



Preferences: Answering Machine

The Answering Machine function provides a convenient way for people to leave you messages when you are busy or even when
you are off-line.

Important: The Answering Machine's ability to retrieve messages sent to you when you are off-line depends on whether or not you
have the Receive Mail option set on the Mail Send/Receive tab.

Message

Enter the message you would like displayed to people who connect to you while your Answering Machine is turned on. You may
enter up to 254 characters for the message. The Answering Machine can be turned on and off from the Personal Communicator
’gidect Chat => Answering Machine => Answering Machine On) or from the PowWow Navigator (click the Answering Machine icon
A

and select Answering machine On). The
F at the bottom of the Personal Communicator window will turn green when the Answering Machine is on.
Answering Machine messages you receive are saved to the Answering Machine file in your PowWow directory. This file consists of
your username with a .PAM extension. For instance, if your username is freddie, the file will be named FREDDIE.PAM. Note:
If your username is longer than eight characters, the name is truncated to eight characters. This may cause file naming conflicts.

Answering Machine On
Check this box to turn on your Answering Machine. You also can turn on and turn off your Answering Machine from the Personal
Communicator Chat menu or the Answering Machine menu in the PowWow Navigator.

Read Answering Machine Messages
Click this button to open your Answering Machine. This is the same as the View Answering Machine option on the Personal
Communicator Chat menu or the Answering Machine menu in the PowWow Navigator.



Preferences: Files and Directories
Specify the various directories in which to:

. store downloaded files
. search for WAV sound files
. place the Address Book and Blocking Book files

Download Directory
This field tells PowWow where to place files sent by other people. By default, PowWow uses its own directory.

Address Book/Blocking Book Directory
This is the directory from which PowWow loads its PowWow Address Book. The default is the directory from which PowWow is
run.

Sound File Directory
This field specifies the directory in which to look for .WAV sound files played by other people. Subdirectories will not be searched.

Alert Wave File

This sound file is played whenever a request is received by PowWow for a chat, file, cruise, or voice chat. By default, PowWow
plays the included LOON.WAV sound file. If no sound file is specified or the computer system cannot play Microsoft .WAV sound
files, PowWow will play the system beep instead. To specify a different .WAV file, enter its complete path and filename or use the
Browse button to select one.



Preferences: Web Browser

Tell PowWow which World-Wide Web browser to use when cruising with Pow\Wow.

Select the Web Browser
Select one of the four Web browsers which PowWow supports. If one of these is not installed on your computer, you will need to

obtain and install a copy. If you do not have a browser, some PowWow functions will not be available. These include searching
the White Pages and Cruising.

Browser Folder and Filename
Important: Specify the complete path. You can use the Browse button to locate your World-Wide Web browser.



Finished Setting Up New User

Congratulations! You’re all finished with your initial setup. If you want to change any of the information you’ve just entered, select

the Configuration button ﬁ from the PowWow Navigator window and then select the Preferences option.

If you would like to add yourself to the PowWow community white pages now, make sure the radio button is selected. When you
click Finish, your chosen web browser will start and take you to the PowWow White Pages web site.

If you would prefer to complete the white pages entries later, click the “I do not wish to add myself” option and then click Finish.

You’ll go directly into the PowWow Navigator window. For information about the Navigator, select the ﬁ button on the window.



Personal Communicator Window



Personal Communicator

The Personal Communicator window is your tool for point-to-point communications with up to eight other people.

has his or her own “pane” in the Personal Communicator window, and each pane has its own set of controls.
The Personal Communicator window is activated when:

. You send a PowWow (chat) request to a person and he or she accepts it
. Someone sends you a PowWow request which you accept

Some functions are exclusive to the Personal Communicator window. These include:

o Send File
o Sound
. Whiteboard

The Personal Communicator window has four sets of controls. In addition to the normal menus, it has a:

o General button bar
o Button bar for each pane
o Participant menu

The following shows the Personal Communicator window with three participants:
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General Button Bar

These are the controls on the Button bar. Notice that, as your cursor passes over an icon, it becomes a colored button.

Click on an area of this graphic for quick information.

Connect Communities
(Address Book) (Address Boalk)  “oice Chat  Whiteboard Games

K@ ﬁfmccﬁqgaﬁ““'ﬂ
~

Hang Up  Send File Crl_use Clear CuikSound White Pages  Calar
=electar




Pane Control Buttons
These are the controls on each participant’s pane. Notice that, as your cursor passes over an icon, it becomes a colored button.

Also note that the icons are generated dynamically and depend on what the person with whom you're chatting has configured. For
instance, if the person does not have a Home Page, that icon will not be displayed.

Click on an area of this graphic for quick information.
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Chat Menu



Frequent Outgoing Pages

This option is available on the Address Book menu in the Navigator or the Chat menu in the Personal Communicator window.
Displays a list of people with whom you have recently requested chats.

Clicking on one of these entries sends a chat request to that person.



Recent Incoming Pages
This option is available on the Address Book menu in the Navigator or the Chat menu in the Personal Communicator window.

Displays a list of people who have recently requested chats with you.

Clicking on one of these entries sends a chat request to that person.



Address Book

This option is available on the Address Book menu in the Navigator or the Chat menu in the Personal Communicator window.

Select this option to open the PowWow Address Book to the Users tab. This lets you quickly select a name and send a chat
request.



Join A Community
This option is available on the Communities menu in the Navigator or the Chat menu in the Personal Communicator window.

Select this option to open the PowWow Address Book to the Communities tab. This lets you quickly select a Community and send
a Join request.

Note: If you have checked "Automatically save all connections to Address Book" in the Communities section of the Runtime
Options, the Community's address automatically will be placed on the Communities tab of your PowWow Address Book. This lets
you easily re-join this Community at a later time.




Buddies Currently Online

Displays the PowWow Navigator window so you can see which buddies are currently on the Internet and running PowWow.



Find Online Users
This option is available on the Buddy List menu in the Navigator or the Chat menu in the Personal Communicator window.

Select this option to start your browser and open the White Pages Search page on the Tribal Voice web site.



Add Current Connections

You can add the address(es) of the person(s) you are chatting with to your address book by selecting Chat => Add Current
Connections from the Personal Communicator menu. If you are chatting with more than one person, you will be prompted to
select which person(s) to add to your PowWow Book. Selecting “All” adds everyone.



Answering Machine

Answering Machine On

If you are away from your machine and would like PowWow to answer and display a message to those trying to contact you, you
can turn on the Answering Machine. When the Answering Machine is on, the “A” in the lower-right hand corner of the Personal
Communicator window will turn green.

When someone attempts to contact you, PowWow will automatically send the message you have configured under Preferences =>
Answering Machine to the remote end. Once the other end has acknowledged the message, the connection will be broken.



View Answering Machine
Select this option to display a dialog which shows messages which have been left for you.

When you’re in this dialog, you can:

Reply to the selected message

Delete the selected message

Delete all messages

Send a PowWow request to the message sender
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Sort Messages
Clicking the appropriate heading lets you sort the messages by Sender’s name, Address, Date (actually the day of the week), Time
and the Message text.



Private Chat

You can chat with someone privately so that what you type is sent only to that person. You can select more than one person to
receive a Private Chat. In this case, what you type will be seen by each participant whom you have designated as Private.

Important: If the other person wants his or her responses to you to be private, he or she must select you for a Private Chat.

When you select this option, if you’re chatting with more than one person, you will be prompted to specify the person with whom to
chat privately.

You also can click the Private button ﬂ on the person’s Personal Communicator pane.

When someone has selected you for a Private Chat, the person's text will be preceded by the notation [Private Begin...].
When the person turns off Private Chat mode to you, the notation [ .. .Private End] is displayed.



Hang Up

Select Hang Up to discontinue chatting with someone and stop all file transfer and cruise connections. This will break the
connection to the person you were chatting or attempting to chat with. If you are chatting with more than one person, you will be
prompted to select the person(s) to disconnect from. Select ‘All’ to disconnect from everyone.

You also can click the Hang Up button E on the main button bar or on the person’s Personal Communicator pane.



Hide Personal Communicator
Selecting this option simply closes the Personal Communicator window. To reopen it, click the Show Personal Communicator

button ﬁ on the PowWow Navigator window.



Edit Menu



Paste
Pastes the text from the clipboard into the chat window.



Clear Chat Text

This command lets you clear the send and receive windows of all text and moves the cursor to the top left hand corner of the send
window. All text currently in the window will be lost. Pressing the Escape key also clears the window.



User Menu



Preferences
Select this option to update your PowWow configuration and to enter and update your user information.



Add New User

Use this option to add a new user, such as another family member, to your account. You’ll use the same wizard you used when
you created your original account.

Important: If you will host a Community, you should create a unique User identity which will be used only as the address for the
Community if you will be logging into PowWow simultaneously from multiple locations. If you start a Community using your
normal PowWow Address and then log in from another computer using that same address, the registration server will update the IP
address associated with that PowWow Address. In effect, your Community will no longer exist and people will not be able to join it.



Select a Directory

Use this dialog to select a directory in which to place the files associated with the new user you are creating. (These files include a
personal POWWOW.INI initialization file and the data file containing the PowWow Address Book information.) If the displayed
directory is not the one you want, click the Browse button and search for a different location.



Change Current User
This changes the current user to a different, previously-entered user. To add a new user, select Add New User instead.



Delete User
This removes a previously-added user. You cannot remove the primary (original) user from PowWow.



Internet Menu



Send PowWow to a Friend

This allows you to send a prepared message to a friend via e-mail. This message gives information about Pow\Wow and provides a
link which will automatically start downloading the latest PowWow version.



Send PowWow to a Friend
Enter your friend's e-mail address and click Send Them PowWow.

Your friend will receive a message telling him or her about PowWow's features and supplying a link which will start the Web browser,
open the Tribal Voice download site and automatically initiate the download of the latest version of PowWow.



White Pages

Important: Selecting any of these options will start your browser, if necessary, and take you to the applicable Tribal Voice web
page.

Search the White Pages
Select this option to go to the Search page so you can search for others to chat with.

Important: The White Pages only list people who have added White Pages entries for themselves and who are online.

Add Yourself to the White Pages
Goes to the Add page so you can add yourself to the White Pages listing so other people can contact you.

Change Your White Pages Entry
Goes to the Change page so you can update your information in the White Pages.

Remove Yourself from the White Pages
Removes all information about you from the White Pages. Others will not be able to locate you.



Recent PowWow Logins
Important: Selecting this option will start your browser and take you to the applicable Tribal Voice web page.

Selecting this option will take you to the Tribal Voice web site and display a listing of the last 10, 25, 50 or 100 people who have
logged into the PowWow server.

If you click a displayed name, you can request a chat with the person.



Online Community Guide
Important: Selecting this option will start your browser and take you to the applicable Tribal Voice web page.

Select this option to go to the Tribal Voice web site and a listing of the various categories of Communities which are registered. You
can click a category to go to a list of the Communities in that category, and then click a Community address to join that community.



Download Latest PowWow Release

Select this option to download the most current version of PowWow. Your browser will start, go to the Tribal Voice download page
and, depending on your browser and its settings, automatically start the download process. Also depending on your browser and
its configuration, the latest version may be:

. Saved to a disk file, which you then execute to install the current version, or
. Placed in a temporary directory and executed automatically by your system.



Tribal Voice Home Page
This option starts your browser and opens Tribal Voice’s home page.



Utilities menu



Send File

When you are in the Personal Communicator window, you can send a file (for example, a picture or a word processing document) to
another person with whom you are chatting. This process is similar to “attaching” a file to an e-mail message.

Establish a “chat” connection with someone.

Select “Send File” from the Utilities menu.

A dialog box will appear asking you to pick the file you wish to send.

When you have highlighted the file you want to send, choose “Open.”

The other person will receive your file transfer request. When they accept it, PowWow will send the file to their computer.
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Web Cruising

When you are in the Personal Communicator window, use this option to lead a group of PowWow users through the Internet with
your browser.

Important: The Frequently Asked Questions document has very important information about browsers which do and do not work
with Cruising. For instance, Microsoft Internet Explorer version 3.0 does not work, while version 3.01 does work.

Note: This function is available only when two or more people are connected through the Personal Communicator.

To lead the people you are chatting with, select the Utilities => Web Cruising option. If your browser is not already running, it will
be launched and a connection to it established. Once PowWow has connected to the browser, the people you are chatting with will
be notified that you would like to lead them in browsing the Internet. They can accept or refuse the cruise request. If they accept,
the browser will be launched on their computers. Once the connections are established on both sides, whenever the “Leader”
opens a new URL, the 'followers' will be routed to the same location.

When you stop cruising, the connections to the browser will be dropped but the browser will remain running.



Sounds

PowWow can play .WAV sound files on the computers of people who are chatting together.

Important: The actual .WAV files are not sent when sounds are played; only the command to play them. If the recipient does
not have a .WAV file which uses the same file name as the one you are playing in his or her PowWow directory or Sound File
path, the person will not hear the .WAV file.  To transfer a .WAV file to another person:

1. Select Utilities=>Sounds=>QuikSound to display the QuikSound dialog.
2. Select the sound you want to transfer.
3. Click the Transfer button. The Quik Transfer dialog is displayed:
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4. Click and drag the sound icon to the recipient's pane in the Personal Communicator window. This starts the normal Send File
function.

Unlike chat, file transfer, cruise or voice chat requests, there are no prompts for playing sound files. When a sound file is played on
one computer, the command to play the sound is sent to the other computer(s). When the sound is played on the other person’s
computer, the icon bar of the sender’s pane will flash green, so the recipient of a sound always knows who sent it.

To prevent sounds from being played:

1. Select Users => Preferences from the Personal Communicator menu.
2. Click the Sound/Voice tab.
3. Un-check the Play Sounds box.

To play a QuikSound sound:

Select Utilities => Sounds from the Personal Communicator menu or press the QuikSound button ﬁ on the button bar.
Select the QuikSound option. The PowWow QuikSound slider bar will appear.

Click to select the sound you wish to play or click and drag the selector bar to highlight the sound.

To play the sound, double-click the name or press your Enter key.
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PowWow lets you use a male or female voice for your Bye, Cool and Hello .WAV files when you chat with other people. To pick a
voice:

1. Select Users => Preferences from the Personal Communicator menu.
2. Click the Sound/Voice tab.
3. Check the Male or Female radio button.



Add New Sounds

To add sounds to PowWow, select Utilities => Sounds =>Add New Sounds from the Personal Communicator menu. You will be
prompted to enter the Sound |.D. (description) and Sound Path and Filename for the sound to add to PowWow.

Important: Before sound files can be heard by anyone else, you first must send them to the other users and they must have the
same filename. You can use PowWow’s file transfer function to send sound or the Transfer function on the QuikSound dialog.

The Sound I.D. is the description of the sound that appears within PowWow and is used to identify which .WAV file to play. The
Sound I.D. can be up to twenty (20) characters long and can contain any mixture of alphanumeric characters, punctuation marks
and spaces.

The Sound Path and Filename entry tells PowWow the name of the .WAV file and where it is located on your computer system. If
no path is specified, PowWow will search the PowWow directory and then the environment path for the .WAV file to be played.
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Sounds: Troubleshooting Problems

Have you recently moved your .WAV files to a different place?

PowWow looks for .WAV files in the directory specified under User => Preferences => Files and Directories in the Sound File
Directory field. If you have moved your .WAV files to a different directory, you will need to change this setting.

Conversely, if you have changed the directory specified, you will need to move the .WAV files to it for PowWow to play them.
Have you installed PowWow to a different directory than a previous installation?

If you install PowWow to different directories, sounds will only be installed properly for the first installation. To fix this, change
the directory specified under User => Preferences => Files and Directories in the Sound File Directory field in each copy of
PowWow to the same directory.

Have you used the PowWow Sound Installer?

The PowWow Sound Installer (PWSI) was designed for use with PowWow for 16-bit Windows (Windows 3.1), which is no
longer supported. PWSI’s functionality has been built into this version of PowWow. To add a Sound Installer File (SIF), drag
it from Explorer onto the QuikSound slider bar.

To fix non-working sounds:

1 Open the QuikSound slider bar.

2. Right-click any sound that is not working and choose Remove. The sound will be removed from the slider bar.

3. Open Explorer or Find Files and locate the .WAV files to install.

4. Select (drag) them from Explorer (or Find Files) into QuikSound. You will be prompted for a description of each sound.



Macros

Use this option to define macros (text strings) which can be assigned to the function keys (F1 through F12) and “played” within the
PowWow Personal Communicator chat window:

1. Select the key you wish to define a macro for.

2. Enter a Macro Label to identify your macro This label will appear in the macros menu.

3. Enter the Macro Definition. This will be sent whenever you select this macro from the Macros menu or press the associated
key.

To find out what this macro will sound like when spoken through Text-to-Speech, you can press the Test Speech button and the
current Macro Definition will be spoken.

The Allow Spoken Macros from Others option enables or disables others from being able to have their macros spoken on your
machine. If this option is enabled, a macro that is sent by others who have the Speak Macros option turned on would be spoken
instead of displayed. If this option is disabled, all macros received will be displayed as text and not spoken.



Choose Macro
Click the name of a defined macro to execute it.



Speak Macros

This reads the macro through PowWow’s built-in speech synthesizer. Providing, of course, the people with whom you are chatting
allow spoken macros.



Voice Chat

PowWow lets you initiate a continuous voice connection with one of the people you are chatting with. A communication speed of
at least 14.4Kbps and an 80486DX or faster CPU in your computer is needed to use the voice chat feature of PowWow.

If you are chatting with more than one other person, you will be prompted to select with whom you would like to talk. A connection
will then be established for the exchange of voice data. To end the voice chat session, de-select the Voice Chat menu item.

If your system can support the Full Duplex setting, you can converse as though you were using a telephone. The Half Duplex
setting function like a CB radio, with each person taking turns speaking and listening.



Voice Connection Controls

When you have established a voice connection with another person, use the controls on this dialog to tailor the quality of the
transmitted and received sounds.

Sent
This is a level indicator of your outgoing volume.

Threshold
Use this to set a background noise value. Everything
below the threshold (the area in red) is not sent.

Volume
Click and drag to change your speaker volume.

Mute
This is only visible during full-duplex mode. Click
Mute to disable your microphone.

Talk
m This is only visible during half-duplex mode. While it

is clicked (on), you are sending your voice (just like a
CB radio). To receive, you have to unclick this button.

Received
This is a level indicator of the received volume.
received

Last
Click this button to replay the last voice transmission
you received.

Duplex
>full du HREE Click here to toggle between Full and Half duplex. If
your sound card won’t support Full duplex, this option
half duplex cannot be changed from Half duplex.

In Full duplex, you are transmitting and receiving
simultaneously, just like using a telephone. In Half

duplex, you can either transmit or receive, like using a
CB radio; but not both.

Note: You may be able to achieve Full duplex support
by updating your sound card drivers.

Quality

If your connections are fast and clear, you can click the
switch to use High Quality. The sound data is
compressed less, which results in clearer speech.

If your connections are not that good, you should select
Low Quality. The sound data is compressed more so
it takes less time to transmit. However, some quality is
lost in the compression.

End
Terminate the voice connection.






Hear All

Select this option to turn on the Text-to-Speech function for all your chat sessions. Then, every message
you receive will be processed by the Text-to-Speech function. Note: PowWow's text-to-speech converter
understands certain abbreviations which you can type and which will be spoken correctly. Click here or
refer to Appendix G: Text-to-Speech Abbreviations of the User's Guide (PWMANUAL.EXE) to see the list of
abbreviations.



Whiteboard

PowWow lets you draw by yourself or collaborating with other people with whom you are chatting in Personal Communicator mode.

To begin drawing, click the Whiteboard EJ button or select Utilities => Whiteboard from the Personal Communicator menu.

When you start a Whiteboard session, the PowWow Whiteboard window will appear. Each side of the Whiteboard window contains
tools:

The left side contains the Drawing, Text and Color Tools

The bottom shows the options for the Drawing, Text and Color tools

The right side contains the Image Options

The top contains the Whiteboard Image Options.

At each corner is a gadget with diagonal lines. Click and drag on this gadget to resize the Whiteboard window.

Between the drawing window and the bottom set of tools is a Help Bar. The Help Bar describes each tool in PowWow as you move
the cursor over it.



Pluglins: Board Games

Playing Games
To open the PowWow Games window:

A |
. From the Personal Communicator window, select Utilities => Plugins => Board Games or click the Games ¥ button. Al
the current games to which you are connected will be displayed in the Games In Progress field.

. From the Group Chat window, click the Games
in the Games In Progress field.

button. All current games in the Community will be displayed
Join

To participate in a game, highlight its name and click the Join button.

New

To start your own game, click the New button. You will launch the Board Games Plugin. Follow the Plugln’s instructions for

starting a new game. Make sure you choose a unique name to identify the game to others.

View
To watch a game, highlight its name and click the View button.

Close
To leave the PowWow Board Games window, click the Close button.

Please refer to the user’s manual for further information about playing the Board Games.



Install New Plugin

This option is not yet enabled.



Window Menu



Always On Top

Selecting Always on Top forces PowWow to remain on top of all other windows on your desktop. By default, this option is off.



Help Menu



Online Technical Support

When you select this option, your Internet browser will start and go to the Tribal Voice Support page. Here you can read the FAQ
(Frequently Asked Questions) and send e-mail to the support staff.



System Information
When you select this Help Menu option, a window displays important information about your system:
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This information is particularly useful if you have a technical support question. (For instance, this is the only place to find your IP
Address.) Simply click the Copy to Clipboard button and paste the information into an e-mail message to support@tribal.com.



About

Select this option to display the version information.



Colors



Setting Colors

You can change the colors which are used by your Personal Communicator window and which appear in both a Group Chat window
and someone else's Personal Communicator window.

To do this:

1. Open your Personal Communicator window if it is not already open.
Using the color selector:

T

2. Left-click the color you want to use as your foreground color and right-click the color to use as the background. The
combination is shown to the right.

This color combination will be used by your pane (the top one) in your Personal Communicator window and in your pane in
someone else's Personal Communicator window. The foreground color will be used to display your text in a Group Chat window.

There are some exceptions to how colors work. Please check the Runtime Options description of color settings in Preferences.



Hear
When you’re in Personal Communicator window, you can turn on Text-to-Speech for selected persons.

To do so, click the Hear button on the person’s button bar.
Note: PowWow's text-to-speech converter understands certain abbreviations which you can type and which will be spoken

correctly. Click here or refer to Appendix G: Text-to-Speech Abbreviations of the User's Guide (PWMANUAL.EXE) to see the list of
abbreviations.



Private Chat

You can chat with someone privately so that what you type is sent only to that person. You can select more than one person to
receive a Private Chat. In this case, what you type will be seen by each participant whom you have designated as Private.

Important: If the other person wants his or her responses to you to be private, he or she must select you for a Private Chat.
To start a Private Chat, click the Private button Plon the person’s Personal Communicator pane.

When someone has selected you for a Private Chat, the person's text will be preceded by the notation [Private Begin...].
When the person turns off Private Chat mode to you, the notation [...Private End] is displayed.



View Picture

If this icon is displayed, it means the person with whom you're conversing has a picture which you can view. When you click this

button, the picture will be displayed in a separate window. (This may take a little while, depending on your connection speed.) You
can save the image or just close the window.



View Home Page

If this icon is displayed, it means the person with whom you're conversing has a web page which you can view. When you click this
button, your Internet browser will be started and will take you to the designated page.



Personal Information

If this icon is displayed, it means the person with whom you're conversing has entered some personal information which you can
view. When you click this button, the information will be displayed in a separate window. (This may take a little while, depending

on your connection speed.)



Join Community

If this icon is displayed, it means the person with whom you're conversing is a member or owner of at least one Community. When
you click this icon, you will start the process to join whichever Community appears first in the person's PowWow Navigator window.

Note: If you have checked "Automatically save all connections to Address Book" in the Communities section of the Runtime
Options, the Community's address automatically will be placed on the Communities tab of your PowWow Address Book. This lets
you easily re-join this Community at a later time.

Hint: If the PowWow registration server is not operating, you still can join a Community. To do so:

1. Page the owner of the Community.

2. When he or she accepts your PowWow request, click the Community @ button on the person's pane. If the Community is first
on the person's Navigator window, you will join that Community.



Toggle Send WAV Sound

If you are chatting with several people in the Personal Communicator and want to play a WAV file only on certain people's
computers, you would select this option for each person. This toggles the QuikSound setting for each person.

To play the sound for the selected people, click the QuikSound button ﬁ or select Utilities => Sounds => QuikSound.

See also: Sounds



Participant Menu

When you right-click in a participant's area (a pane) of the Personal Communicator window, this menu is displayed:
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You'll notice that, except for the first two options, all other selections are available on other menus or on the Pane Controls.
menu consolidates the more frequently-used operations for your convenience.

Add to Address Book
Select this option to place this person's name and PowWow Address in the Users tab of the Address Book.

Add to Blocking Book
Select this option to place this person's name and PowWow Address in the Refuse section of the Blocking Book.

This



White Pages

Select this button on the general button bar to start your Web browser (if necessary) and open the Search the White Pages page at
Tribal Voice's Web site.



Glossary



Glossary

Bitmap
A bitmap defines a display space and the color for each pixel or "bit" in the display space. A GIF and a JPEG are examples of
graphic image file types that contain bitmaps.

A bitmap does not need to contain a bit of color-coded information for each pixel on every row. It only needs to contain information
indicating a new color as the display scans along a row. Thus, an image with much solid color will tend to require a small bitmap.

Because a bitmap uses a fixed (raster) method of specifying an image, the image cannot be immediately re-scaled by a user without
losing definition. A vector graphic image, however, is designed to be quickly re-scaled.

Community
A virtual meeting place.

Cruise
A World-Wide Web browsing session in which the Leader sends people to the same World-Wide Web sites loaded in his World-
Wide Web browser.

Cruise Leader
See Leader.

Domain Name
The “name” of a particular network of computers attached to the Internet. For example, all of Tribal Voice’s networked computers
have a domain name of tribal.com. See also fully-qualified domain name.

Dynamic IP Address
An Internet protocol address that changes each time a connection is made to an Internet service provider. This type of connection
is usually used with dial-up Internet accounts accessed via modem.

Fixed IP Address
An Internet protocol address which remains the same. Networked computers and other computers with a dedicated connection to
the Internet typically have fixed IP addresses.

FQDN
See fully-qualified domain name.

Fully-qualified Domain Name

The complete name for a computer on the Internet, consisting of the computer name and the domain name. For example, if your
computer is called ibmpc15%engineering and your domain name is tribal.com then your fully-qualified domain name is
ibmpc15%engineering.tribal.com. Usually only computers with permanent Internet connections and fixed IP addresses have a
fully-qualified domain name. If your access is through a commercial Internet Service Provider it is unlikely you have a fully-qualified
domain name.

Internet Service Provider
The company responsible for providing your Internet access.

IP Address

A numeric address used to identify a computer or other device (printer, router, and so forth) over the Internet. IP addresses are
composed of four sets of numbers with values of 0-255. For example: 204.227.15.1 is the IP address for the Tribal Voice’s World-
Wide Web server.

ISP
See Internet Service Provider.

JPEG
Joint Photographic Experts Group. JPEG is a popular method used to compress photographic images.

Generally speaking, JPEG is superior to GIF (Graphics Interchange Format) for storing full-color or gray-scale images of "realistic"
scenes; that means scanned photographs, continuous-tone artwork and similar material. Any smooth variation in color, such as
occurs in highlighted or shaded areas, will be represented more faithfully and in less space by JPEG than by GIF. Unlike a GIF, a
JPEG is always full 24-bit color, so on anything but a 24-bit monitor it will always be dithered by the browser.

Also, unlike the GIF format, JPEG is free; it requires no user's or developer's license. Unisys owns some patents to key parts of
the GIF compression technology and charges license fees.

Leader
The person who first initiates a PowWow cruising session. The Leader has control of cruising the World-Wide Web.

Local PowWow Address



Your PowWow Address. In general, this will be your normal e-mail address, such as freddie@mynet.net.

Local Server
See PULS Server.

Local User ID
See Local PowWow Address.

Moderator
The person who runs a Community.

Plugin
A module which can be added to PowWow to provide additional functionality.

POP3
Post Office Protocol version 3. The de-facto method of retrieving electronic mail over the Internet.

PPP
Point-to-Point Protocol. A common method for connecting to the Internet using a modem.

PULS Server

The PowWow User Local Server (PULS) server is the computer PowWow registers itself with. Tribal Voice runs a PowWow Server
which all copies of PowWow attempt to register with. You can also install your own PowWow Server to allow PowWow to register
with your own private server.

Remote PowWow Address
Anyone else’s PowWow Address.

Remote User ID
See Remote PowWow Address.

SLIP
Serial Line Interface Protocol. A common method for connecting to the Internet using a modem.

SMTP
Simple Mail Transport Protocol. The de-facto method of sending electronic mail over the Internet.

Socket

A socket is a network communications endpoint. It is analogous to a physical cable (the network data connection) being plugged
into a socket, but is implemented entirely as a software construct. PowWow sends and receives messages by opening a socket
and reading and writing data to and from the socket. This simplifies program development because the programmer only needs to
worry about manipulating the socket and can rely on WinSock.dll, the Windows socket controller, to actually transport messages
across the network correctly.

Sockets are created and manipulated using numerical values. Errors can occur if two programs each use a socket having the
same identifier. Although not too common, this does happen and WinSock.dll usually generates an error message such as "Unable
to create socket," or one which is equally helpful. For some good information about sockets and error messages you can do
something about, go to http://www.sockets.com. (We'd print the information here, but it is copyrighted.)

Note that a socket is not a port, though there is a close relationship between them. A socket is associated with a port, though this is
a many-to-one relationship. Each port can have a single passive socket, awaiting incoming connections, and multiple active
sockets, each corresponding to an open connection on the port.

Spam

Noun. Unsolicited e-mail. It resembles a combination of junk mail addressed to "Occupant" and unsolicited calls from tele-
marketers. It wastes the recipient's time and the resources of the Internet. The only people who like it are those who (think they)
are making money by using it. The rest of the world thinks of spammers and boiling oil.

Spam often is to a list culled from subscribers to a Usenet discussion group or obtained by companies that specialize in creating e-
mail distribution lists.

Verb. To post irrelevant or inappropriate messages to one or (usually) more Usenet newsgroups or mailing lists in deliberate or
accidental violation of netiquette. See also Spew.

Evidence indicates that the term is derived from a famous Monty Python sketch ("Well, we have Spam, tomato and Spam, egg and
Spam, Egg, bacon and Spam...") that was current when spam first began arriving on the Internet. Spam is a trademarked Hormel
meat product that was well-known in the U.S. Armed Forces during World War II.

Spew
While spam refers to the mass sending of an e-mail or newsgroup posting to a large number of people who would otherwise not be



interested in seeing the letter or post, spew refers to a participant in a Community who goes on and on about something or types the
same thing repeatedly.

Static IP Address
See fixed IP address.

TCPI/IP
Transmission Control Protocol/Internet Protocol. The specification for how computers communicate over the Internet.

URL
Uniform Resource Locator. A standard method of displaying a resource, such as an HTML document or FTP site, on the World-

Wide Web.



Miscellaneous Information



Support

In addition to extensive online Help, a User's Manual and a Community Administration Supplement, Tribal Voice offers technical
support for PowWow by e-mail, fax and PowWow.

The User's Manual and the Supplement are in the form of stand-alone executable files which display the information much like a
Web browser. The User's Manual is PWMANUAL.EXE and the Supplement is PWHOST.EXE. Because the files are large, these
documents are a separate download from the PowWow program file. The files also are available in standard HTML format and can
be viewed online at the Tribal Voice Web site, http://www.tribal.com/.

Please check the files HISTORY . TXT and PW-FAQ . HTM, which come with PowWow. The HISTORY . TXT file contains errata and
late-breaking news not covered in the online help. The PW-FAQ.HTM file, viewable by your World-Wide Web browser, contains
answers to Frequently-Asked Questions about PowWow.

The answers to most of the most commonly-asked questions about PowWow can be found in your PowWow Frequently-Asked
Questions document (filename: PW-FAQ.HTM). Use the FAQ for an immediate answer to your question. The FAQ also is
continually updated and can be viewed on the Tribal Voice Web site, http://www.tribal.com/.

Technical support is available via PowWow from 9:00AM to 5:00PM Mountain Time [GMT-7], Monday through Friday (excluding
major US holidays) by chatting with powwow-support@tribal.com.

Technical support is available via fax 24-hours-a-day, 7-days-a-week by sending a fax to +1 (719) 687-0716.

If you have any comments about the online help or the documentation, please send e-mail to powwow-docs@tribal. com.
Please note that this is not for technical support.

Before Contacting Technical Support
When contacting technical support with a question, please have the following information available or enclosed in your e-mail:

. Your name, e-mail address, fax and telephone number.

. PowWow version number and the date and time of your POWWOW . EXE program file. You can find your version by clicking
Help=>About PowWow from the menu.

. A list of all PowWow Pluglins installed, if any, and their version numbers.
e Adetailed description of the problem you are experiencing.

. Brand and version of TCP/IP protocol stack (WINSOCK.DLL or WSOCK32.DLL file). You can find this by selecting
Help=>About PowWow=>Info from the menu.

. If the problem is sound-related, include the brand, model and version of sound card and drivers. If you are unsure, contact
your sound card manufacturer or computer vendor.

. Computer software type (operating system name and version, brand and version of other network drivers, video driver settings,
plus the name and version of any device drivers or other memory-resident programs).

. Computer hardware type (type and make of CPU, RAM, hard disk type and size, video and network cards installed plus any
other unusual cards).

e  System configuration files (AUTOEXEC . BAT, CONFIG. SYS, MS-Windows . INI files and so forth).

. Network configuration (TCP/IP stack brand and version, type and speed of Internet connection, Internet service provider name
and contact, if any).

The majority of this information can be found by running a utility such as CyberMedia’s FirstAid, Microsoft’s System Diagnostics
(included with MS-DOS and Microsoft Windows), Quarterdeck’s Manifest, Peter Norton Computing’s System Info, and so forth.



About Tribal Voice

Tribal Voice is a collection of software engineers located as far from civilization as access to T-1 lines will permit. We are currently
holed up in a small Rocky Mountain town on the slopes of Pikes Peak at an elevation of 8,500 feet (3,088 meters) above sea level.
We have no plan and write software as it occurs to us: in stream-of-consciousness mode.

PowWow is the copyrighted property of Tribal Voice. It may be used free-of-charge for personal use by individuals and educational
institutions. Anyone else wishing to use PowWow should contact Tribal Voice for licensing information.

Tribal Voice
FAX 1-(719) 687-0716
E-MAIL sales@tribal.com



Overview
Welcome to PowWow!

PowWow is a unique personal communications program for the Internet. It offers two main functions:

1. APersonal Communicator
2. A Community conferencing system

As a personal communicator, it lets you:

Call your friends

Chat with up to eight (8) people by keyboard or voice
Show a picture of yourself

Send and receive files

Play MS-Windows .WAV format sound files

Browse the World-Wide Web together as a group

e o o o o o

All you need to know to communicate with another PowWow user is his or her e-mail address. PowWow automatically will connect
with them, provided PowWow is running on their computer.

In Community mode, PowWow lets join a Community or, if you have a license to host a Community, even set your computer up as a
server. Up to 1,000 people can share a Community simultaneously. You may set yourself up as a temporary community, or you
can run your community permanently around-the-clock. You may choose to be the community moderator or you can create a full-
time non-moderated community.

PowWow runs both Personal Communicator and Community modes at the same time. If you are hosting a community or
connected to one, you can still talk with other people running PowWow and use all the personal communicator functions.

PowWow comes with a file named HISTORY . TXT which contains late-breaking news and other information not covered in the online
help. Please check this file before continuing with this help file.

The file README . TXT introduces PowWow and tips on installation.
A copy of the PowWow Frequently-Asked Questions Guide is also included. The document is an HTML document containing the
answers to many common questions about PowWow. The name of this file is PW-FAQ.HTM and it can be viewed with any World-

Wide Web browser.

The latest version of PowWow, along with technical support and information about Tribal Voice, may be found on the Tribal Voice
World-Wide Web server at <http://www.tribal.com/>.






Address Book: Users Tab

This tab lists the addresses of people with whom you chat.
Note: [f you right-click an entry, a menu provides direct access to the PowWow, Edit, Remove and Buddy Status functions.

What the Symbols Mean
The symbols by an address book entry provide the following information:

ﬁ The gray icon indicates a standard entry.

ﬁ The orange icon indicates the person is on your Buddy List.

e The eye indicates you are on the person’s Buddy List.

ﬁ The question mark indicates the person has sent you a Buddy Request to which you have not yet replied.

Right-Click Options
These options, which are explained below, are available by right-clicking an existing entry:

pwiest2 @tribal.co

ﬁ Powisiow

o4 Edit
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ﬁ Buddy Status L

Add an Entry

To add someone to your Address Book, click the Add button and enter their PowWow (email) address, name, and a brief comment
about him or her. If you wish to know when this person is running PowWow, check the Make them a buddy box to add them to
your Buddy List. When finished, click OK to save the information, or Cancel to abort.

Send Chat Request (Page / PowWow)
To page someone in your Address Book, double-click their name or PowWow address. To page someone who is not in your
Address Book, enter the person’s PowWow address in the Address field and click the PowWow button or press Enter.

Search White Pages
To search the White Pages directory of PowWow users, click the Find Online Users button. PowWow will launch your World-Wide
Web browser and display the White Pages search page.

Edit Entry

To change the information on someone in your Address Book, including removing them from your Buddy List or removing yourself
from their Buddy List, click the Edit button. You will be able to edit their address, name and comment and can remove them from
your Buddy List or remove yourself from their Buddy List.

Remove an Entry

To remove someone from your Address Book, click the Remove button. You will be prompted to confirm the removal from your
Address Book.

Buddy Status

You can add a person to your Buddy List or delete yourself from someone's Buddy List by right-clicking an entry and selecting the
Buddy Status option. The new options which are displayed depend on your current status.

. If the person is not on your Buddy List and you are not on the person's Buddy List, this is the option:

= Add to BuddyList

Select this option to send the person a Buddy Request.

. If the person is on your Buddy List but you are not on the person's Buddy List, this is the option:

fﬂ Bemowve from BuddyList

Click this option to remove the person from your Buddy List. You will no longer receive notice when the person is online.



. If the person is on your Buddy List and you are on the person's Buddy List, this is the option:

Click Remove from BuddyList to remove the person from your Buddy List. You will no longer receive notice when the person
is online.

Click Remove Yourself from their BuddyList to remove yourself from the other person's Buddy List. He or she will no longer
receive notice when you are online.

. If the person is not on your Buddy List but you are on the person's Buddy List, this is the option:

= Add to BuddyList
ﬁ Remove Yourself from their Buddylist

Click Add to BuddyList to send the person a Buddy Request.

Click Remove Yourself from their BuddyList to remove yourself from the other person's Buddy List. He or she will no longer
receive notice when you are online.

Close
Click this button to close your Address Book.



Add a Buddy
Add an Address Book Entry
Edit an Address Book Entry

This is a multi-use form.
Depending on how you accessed it, you can use this dialog to:

. Request to add a person to your Buddy List
e  Add an entry to your Address Book
. Edit an entry in your Address Book

The following options can appear:

PowWow Address
Enter the correct address for the person.

Name / Handle
Enter the person’s name.

Make Them a Buddy

Check this box if you want to send the Buddy Request message to the person. The person’s name will be added to your Buddy
List and will be identified with a question mark:
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If you do not check this box, the information will be added to your Address Book but the person will not be asked to be added to your
Buddy List.

Remove from Buddy List
Check this box to remove this person from your Buddy List. You will no longer be alerted when this person is online.

Remove Yourself from Their Buddy List
Check this box to remove yourself from this person’s Buddy List. He or she will no longer be alerted when you are online.

Comment
Enter any additional information.

Direct Connection
Note: This option is primarily for internal network use. Also, it is not applicable from the Add A Buddy dialog.

When this option is checked, you will need to enter a machine name or IP address in the PowWow Address field. Then, when a
connection is attempted, PowWow will try to connect directly with the provided address rather than going through the PowWow
server at Tribal Voice.

Note that this option is not useful if the target uses a dynamic IP address, such as that provided by Internet Service Providers when
a user logs on.



Address Book: Communities Tab
This tab lists the addresses of Communities of which you are a member.

Right-Click Options
These options, which are explained below, are available by right-clicking an existing entry:

newusersi@tribal.co
@ Join
(4 Edit
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Add a Community
To add a Community to your Address Book, click the Add button and enter the PowWow (email) address and Topic for the
Community. If you wish to join the Community automatically when you run PowWow, check the Auto-Connect on Startup box.

Direct Connect
Leave the Direct Connect box un-checked unless the Moderator who runs the Community tells you to check it.

Join
To join a Community in your Address Book, double-click its name or PowWow address. To join a Community not in your Address
Book, enter its PowWow address in the Address field and click the Join button or press Enter.

Online Community Guide
To search the White Pages directory of PowWow Communities, click this button. PowWow will launch your World-Wide Web
browser and display the results.

Edit
To change information on a Community in your Address Book, highlight the name and click the Edit button. You will be able to edit
the address, topic and comment.

Remove
To remove a Community from your Address Book, click the Remove button. You will be prompted to confirm its removal.

Click the Close button to close your Address Book.



Address Book: Recent Pages Tab

This tab logs the names, addresses and times people have requested a chat while PowWow was running on your computer.

Right-Click Options
These options, which are explained below, are available by right-clicking an existing entry:

qatestZ2@tribal.co
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PowWow (Page)
To return a page from someone, highlight the name and click this button, or double-click the name or PowWow (email) address.

To page someone who is not in your log, enter the name in the Address field and click this button or press Enter.

Add
To add a person to your User tab list, highlight the name and click this button.

Clear Log File
Click this button to clear the list.

Find Online Users
To search the White Pages directory of PowWow users, click this button. PowWow will launch your World-Wide Web browser and
display the White Pages search page in it.

Important: A successful search requires that the person has a White Pages entry and is online.



Address Book: Blocking Book Tab

The Blocking Book lets you control who is able to contact you for a PowWow. There are three modes from which you can choose
(one at a time): Accept, Refuse, and None. When you change the mode, the list changes.

Important: The modes are mutually exclusive. That is, only one can be in effect at any one time. The restrictions take effect as
soon as you click the radio button.

Right-Click Options
These options, which are explained below, are available by right-clicking an existing entry:

fred@ifrldr.go
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Current Blocking State

Accept
Only those people listed in the Address screen can page (PowWow) you. Once you are in this mode, you can Add people to
the list of those who are able to contact you.

Refuse
People listed in the Address field cannot page you. If there is someone you do not wish to communicate with, you can add the
person’s email address to this list and any chat requests they make will be automatically declined.

Note that anyone not on this list can page you.

None
This is the Default. It means that no-one is blocked from contacting you; therefore, anyone can contact you.

Add
Note that the Add button is active only in Accept and Refuse modes.

When you click the Add button, a new dialog lets you enter the applicable information about the person you're placing on the Accept
or Refuse list.

Addition Type/Address to Add
Select the type of address you wish to use and then enter it in the Address field.

PowWow Address

This is the person's normal PowWow (e-mail) address which you can see by right-clicking the person's name in the
Navigator window and selecting the Connection Info option. This choice assumes that the person will not change his or
her PowWow address.

IP Address

You can obtain the IP Address by right-clicking the person's name in the Navigator window and selecting the Connection
Info option. This is a good choice if the person has a fixed IP Address. However, most users are assigned dynamic IP
Addresses by their Internet Service Providers. That is, their IP Address is different each time they connect to the ISP.

Domain Address

This last lets you filter page requests based on the person using a particular service (ISP). The problem with using this
method is that it will affect requests from everyone who uses the Domain.



Addition Type
Addition Type/Address to Add
Select the type of address you wish to use and then enter it in the Address field.

PowWow Address

This is the person's normal PowWow (e-mail) address which you can see by right-clicking the person's name in the Navigator
window and selecting the Connection Info option. This choice assumes that the person will not change his or her Pow\Wow
address.

IP Address

You can obtain the IP Address by right-clicking the person's name in the Navigator window and selecting the Connection Info
option. This is a good choice if the person has a fixed IP Address. However, most users are assigned dynamic IP Addresses
by their Internet Service Providers. That is, their IP Address is different each time they connect to the ISP.

Domain Address

This address type lets you filter page requests based on the person using a particular service (ISP). The problem with using
this method is that it will affect requests from everyone who uses the Domain.



User Menu

(right-click a user’s name)



Insta-Voice Message
Select this option to create and send a voice message directly to the person on whose name you right-clicked.

Access this option by right-clicking a user’s name in the PowWow Navigator window.



Create Insta-Voice Message
To create an Insta-Voice Message, simply click the Play button and begin speaking in your microphone.

Stop
Fecard

As you speak, the volume and how long you’ve spoken (a one-minute maximum) are depicted:

Yalume

Duration {Length)

Stop
When you’re finished, click the Stop button.

Play
If you’d like, you can play back what you’ve recorded before you send it. Click the Play button.

Send
Click Send to transmit your voice message to the recipient.



Instant Message
Select this option to create and send a text message directly to the person on whose name you right-clicked.

Access this option by right-clicking a user’s name in the PowWow Navigator window.



Send Instant Message

Type in any text message you like just as if you were using a text editor such as Wordpad. Your text will wrap to the display area;
you do not need to press Enter at the end of each line. You also can paste text which you've copied into the Windows clipboard.
Just press Ctrl+V.

To send the message, click the Send button.

To cancel the message, click the Cancel button.



Send URL

Use this option to send a URL address to someone via an Instant Message.
Access this option by right-clicking a user’s name in the PowWow Navigator window.
When you select this option, a dialog opens in which you can enter the URL:
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Important: If your Internet browser is open, the URL of the displayed page automatically is inserted in this field. This makes it
very easy to pass on a good web site.

Receiving a URL

When you receive a URL, you’ll hear the alert signal, the name of the person who sent the message will move to the top of the
Community listing and a small blue “letter” icon will blink by the name, such as:

&

To retrieve the message, double-click the person’s name. A window will open in which the URL is displayed:
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In addition to the normal Instant Message window functions, you can click the Open URL button to start your browser (if necessary)
and open the designated web site.



Send URL to ...

Important: If your Internet browser is open, the URL of the displayed page automatically is inserted in this field. This makes it
very easy to pass on a good web site.

You can edit a displayed URL or you can enter a new one.

Click the Send button to send the message to the recipient.



PowWow

A PowWow is a personal chat session which uses the Personal Communicator window instead of the general Group Chat window.
You can have personal chats with up to eight people at a time — your Personal Communicator window will divide itself into up to
eight panes; each having its own set of controls.

Access this option by right-clicking a user’s name in the PowWow Navigator window.
When you select the PowWow option:

. The request is sent to the selected person.

. A Request a PowWow message is displayed on the person’s monitor.

. The person can accept or reject the PowWow request.

. If your request is accepted, the Personal Communicator window opens (if necessary) or a pane opens.

Note: If you have checked "Automatically save all connections to Address Book" in the Personal Communicator section of the
Runtime Options (please refer to Appendix A: Preferences), the person's PowWow address automatically will be placed on the
Users tab of your PowWow Address Book. This lets you easily page this person at a later time.



Read Instant Message
This option is available if this user has sent you an Instant Message. Select this option to read the message.



Add to / Remove from Community WatchList

When you select this option, the person’s name on which you’ve right-clicked is moved to the top of the Community’s online user
list and the person’s PowWow icon changes to green. Whenever this person is online, the name will be highlighted and will be at
the top of the list.

Access this option by right-clicking a user’s name in the PowWow Navigator window.

To remove a person from your WatchList, right-click on the name and select the Remove option.



Remove from BuddyList / Cancel Buddy Request

Access this option by right-clicking a user’s name in the PowWow Navigator window.

Select this option to:

. Remove this person from your Buddy List.
When you remove a person from your Buddy List, you will no longer be alerted when he or she is online.

. Cancel a request you started with the Request to be a Buddy option.



Request to be a Buddy

Select this option to send a request to the person that you would like to add him or her to your Buddy List (so you’ll know whenever
the person is online).

Access this option by right-clicking a user’s name in the PowWow Navigator window.

Note: When you select this option, the person’s name is moved into your Buddy List area and the PowWow icon becomes a large
question mark. To cancel the request, right-click the name again and select the Cancel Buddy Request option.

When the person receives the request, he or she will have the option of accepting the request or not:
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Connection Info

Access this option by right-clicking a user’s name in the PowWow Navigator window.

Note: Double-clicking the person's name will display this Connection Information if the person does not have a Personal Profile.
Select this option to display the following information about the person on whose name you right-clicked:

Real Name or Handle

PowWow (e-mail) address

IP Address
Time stamp

e o o o

You can copy all this information to the Windows clipboard by selecting the Copy to Clipboard button.

Important: This is the information you will need to provide to report an abuser.



Connection Information
The following information is presented about the person on whose name you right-clicked:

Real Name or Handle
PowWow (e-mail) address
IP Address

Time stamp

You can copy all this information to the Windows clipboard by selecting the Copy to Clipboard button.

Important: This is the information you will need to provide to report an abuser.



Personal Profile
Access this option by right-clicking a user’s name in the PowWow Navigator window.

Note: If the person has a Personal Profile, you can double-click his or her name to display it. If the person does not have a
Personal Profile, double-clicking the name will display the Connection Information.

If this option is active, it means the user you have selected has entered some personal information (Preferences=>Personal Profile)
which you can view. When you select this option, the information will be displayed in a separate window. (This may take a little
while, depending on your connection speed.)



View Picture

Access this option by right-clicking a user’s name in the PowWow Navigator window.

If this option is active, it means the user you have selected has a picture which you can view. When you select this option, the
picture will be displayed in a separate window. (This may take a little while, depending on your connection speed.) You can save
the image or just close the window.

Note: If you Save the image, an entry is made in the [PICTURES] section of the active POWWOW.INI file. The entry links the
person's PowWow Address with the name of the saved image. Then, if you choose to view the same person's picture again,
PowWow will ask if you want to use the saved image, which will be quicker than downloading the image again. However, if the
person changes pictures regularly, you should download the new image to make sure you see the most current.



View Homepage

Access this option by right-clicking a user’s name in the PowWow Navigator window.

If this option is active, it means the user you have selected has a web page which you can view. When you select this option, your
Internet browser will be started and will take you to the designated page.



Select
Access this option by right-clicking a user’s name in the PowWow Navigator window.

When you Select a person in the Community list, you will see only that person’s messages in the Group Chat window. You can
Select as many participants as you want.



Drop

Access this option by right-clicking a user’s name in the PowWow Navigator window.

When you Drop a participant, you will see all messages except those sent by the Dropped person. You can Drop as many
participants as you want.



Private
Access this option by right-clicking a user’s name in the PowWow Navigator window.

When you designate someone as Private, anything you type in the general Group Chat window will be seen only by that person.
You can designate as Private as many participants you want.



Hear
Access this option by right-clicking a user’s name in the PowWow Navigator window.

Selecting Hear turns on the Text-to-Speech function for messages sent by that person.
Note: PowWow's text-to-speech converter understands certain abbreviations which you can type and which will be spoken

correctly. Click here or refer to Appendix G: Text-to-Speech Abbreviations of the User's Guide (PWMANUAL.EXE) to see the list of
abbreviations.



Hang Up
This option is available only if you are the Moderator or Administrator. It lets you Hang Up (disconnect) the selected participant so
he or she can no longer participate in the Community.

Access this option by right-clicking a user’s name in the PowWow Navigator window and selecting the Moderator Options item.

To permanently block the selected individual, select the Add to Blocking Book option.



Reset All

Access this option by right-clicking a user’s name in the PowWow Navigator window.

Select this option to clear the Select, Drop, Private and Hear settings from all affected participants on your PowWow Navigator list.



Moderator Options
This option is available only if you are a Moderator or Administrator of this Community.

Access this option by right-clicking a user’s name in the PowWow Navigator window.
When you select this option, two additional options are displayed. Click an option for a description.

2 HangUp
73 4dd to Blocking Book. .




Add to Blocking Book

This option is available only if you are the Moderator or Administrator. It lets you add the selected participant to the Community
Blocking Book so he or she can no longer access the Community.

Important: The selected person always is added to the Refuse section of the Blocking Book, independent of the current mode of
the Blocking Book (Refuse, Accept or None). However, for refusals to be in effect, the Blocking Book must be in Refuse mode.
Refer to the Blocking Book tab for more information.

Access this option by right-clicking a user’s name in the PowWow Navigator window and selecting the Moderator Options item.
Click the Add to Blocking Book option to display a new dialog.




Add to Blocking Book
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The person's complete PowWow Address and IP Address are displayed on the top lines. You can block based on these
parameters by clicking the applicable radio button:

PowWow Address
This is the default blocking option. Anyone using this PowWow / E-mail address will not be permitted to join this Community. Of
course, the person can create a new address and try again.

IP Address
This is a good choice if you suspect that the person has a fixed IP Address. However, most users are assigned dynamic IP
Addresses by their Internet Service Providers. That is, their IP Address is different each time they connect to the ISP.

Domain Class

The person's IP address is broken into its component elements. In extreme cases, you can block entire ranges of addresses. This
will work against an individual who changes his or her PowWow Address and who has a dynamic IP Address. Unfortunately, this
method also may block participants who use the same ISP, and who, therefore, share part of the IP Address.

The three choices range from C, which is fairly specific, to A, which is very general and which will block all users of a particular ISP.



Community Menu from Navigator and menus in Group Chat window

(right-click a Community name)



Navigator Community Menu

To view the options which are available within a Community, simply right-click the Community’s name in the list. A menu is
displayed, from which you select one of the options. Click the menu option for more information.
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Group Chat

Access this option by right-clicking a Community name in the PowWow Navigator window.

Select this option to display the PowWow Group Chat window.



Bulletin Board
Access this option either by:
. Right-clicking a Community name in the PowWow Navigator window

. Clicking the Bulletin Board button on the Group Chat window
. Selecting the Bulletin Board option from the Modules menu in the Group Chat window

Select this option to display the Community’s Bulletin Board so you can read and post messages of interest to the members of the
Community.



Guest Book

Access this option either by:

. Right-clicking a Community name in the PowWow Navigator window

. Clicking the Guest Book button on the Group Chat window

. Selecting the Guest Book option from the Modules menu in the Group Chat window

Select this option to display the Community’s Guest Book. You can sign it and leave a little information and you can read the
comments other people have left.

If you find an interesting comment, you can click the PowWow Me button.



Community Guest Book
Learn a little about other people who frequent this Community and provide some information about yourself.

The upper area lists the people who have signed the Guest Book. These names are displayed in bold-face until you select one to
read.

The lower area displays the information the person has provided. If the comments interest you, click the PowWow Me button to
page the person.

To leave your own comments, click the Sign button at the upper right of the window.



Sign the Guest Book

The comments form is filled-in with the same information you provided on the Personal Profile tab in Preferences. You can change
any of the information or leave it as is. To post the information, click the Sign It button.



Games

Access this option either by:

. Right-clicking a Community name in the PowWow Navigator window

. Clicking the Games button on the Group Chat window

. Selecting the Games option from the Modules menu in the Group Chat window

Select this option to open the PowWow BoardGames window.



Auto-Connect / Auto-Create at Startup

Access this option either by:

. Right-clicking a Community name in the PowWow Navigator window
. Selecting the Auto-Connect or Auto-Create at Startup option from the Community menu in the Group Chat window

If you are a normal user, this option reads "Auto-Connect." Select this option to automatically reconnect this Community when you
start PowWow.

If you are the owner of this Community, this option reads "Auto-Create." Select this option to automatically create and start this
Community when you start Pow\Wow.



Add to Address Book

Access this option either by:

. Right-clicking a Community name in the PowWow Navigator window
. Selecting the Add to Address Book option from the Community menu in the Group Chat window

If the selected Community interests you and it is not already in your Address Book, select this option to add it to your Address Book.

A new dialog displays so you can add your own information about the Community.



Add Community to Address Book
Use this dialog to add the selected Community to your Address Book.

PowWow Address
This field contains the correct address for the Community. Although you can edit this information, there is no reason to.

Topic

This field contains the information provided by the Community. You can edit this information.

Comment
Enter any descriptive comments you’d like.

Auto-Connect at Startup
Check this box if you want to join this Community automatically whenever you start Pow\Wow.

Direct Connection
Note: This option is primarily for internal network use.

When this option is checked, you will need to enter a machine name or IP address in the PowWow Address field. Then, when a
connection is attempted, PowWow will try to connect directly with the provided address rather than going through the PowWow
server at Tribal Voice.

Note that this option is not useful if the target uses a dynamic IP address, such as that provided by Internet Service Providers when
a user logs on.



Exit Community
Access this option either by:

. Right-clicking a Community name in the PowWow Navigator window
. Selecting the Exit Community option from the Community menu in the Group Chat window

If you are a normal user, select this option to exit the Community. This does not close PowWow.

If you are the owner of this Community, select this option to close the Community. This does not close Pow\Wow.



Administrate
This option is active only if you are the owner or administrator of this Community.

Access this option either by:

. Right-clicking a Community name in the PowWow Navigator window
e  Selecting the Administrate option from the Community menu in the Group Chat window

Select this option to change any of the Community's parameters you set when you created the Community.



Blocking Book

This option is active only if you are the Moderator or Administrator of this Community.

Access this option either by:

. Right-clicking a Community name in the PowWow Navigator window
e  Selecting the Blocking Book option from the Community menu in the Group Chat window

Select this option to open a subset of the PowWow Address Book Blocking Book tab.



Set Recent Login Timeout
This option is available when you right-click a Community's Recent Logins entry in the PowWow Navigator window:

@ P o Tester 1 [1]
Recent Loging [0]

When people enter a community, their names first are placed in the Recent Logins section for approximately 30 seconds (the default
time). Select this option to change this time.



Recent Logins Timeout

Leave People In ...
When people enter a community, their names first are placed in the Recent Logins section for approximately 30 seconds (the default
time). Enter new values in the Minutes and Seconds fields to change this duration. The minimum time is 10 seconds.

Note that all times are approximate.



Group Chat window new menu items



Close Group Chat Window

This option is available from the Community menu of the Group Chat window.

Select this option to close the window.



Send (Text)

This option is available from the Text menu of the Group Chat window.

To transmit your comments to the Community, select this option or press Enter or click the Send button.



Clear (Text)

This option is available from the Text menu of the Group Chat window.

Select this option or click the Clear button to erase your comments before you transmit them.



Erase Window
This option is available from the Text menu of the Group Chat window.

Select this option or click the Erase button to clear all the text from the Visitors display area.



Change Color

This option is available from the Text menu of the Group Chat window.
Use this option to change the color of the text you type and which appears in the other participants' Group Chat windows.

When you select this option, a color palette opens. Click the color you want to use.



Logging

This option is available from the Utilities menu of the Group Chat window.

You can save (log) all the typed activity in a Community. To toggle conversation logging on and off, select this option or click the
Logging switch. Note: Logging conversations for busy Communities can use up disk space quickly.

When you select the Logging option, you'll be able to name the log file. These files default to having a .CLG extension. e.g.:
MYLOG.CLG. These are plain text files which can be viewed by any word processing program or editor, including WordPad and
NotePad, which are supplied with Microsoft Windows.



Hear All
This option is available from the Utilities menu of the Group Chat window.
To toggle the speech synthesizer on and off, select this option or click the Hear switch. An H will appear by everyone’s name in the

Community Display window, signifying that you can hear what they type. Note: PowWow's text-to-speech converter understands
certain abbreviations which you can type and which will be spoken correctly. Click here to see the list of abbreviations.




Cruise
This option is available from the Utilities menu of the Group Chat window.
If this is a Moderated Community, the Moderator's window will have this option active on the Utilities menu and will have the Cruise

button. He or she can select this option of click this switch to start the Internet browsers on Community participants' computers and
lead people on a tour of the World Wide Web.



Visitor Count
If you are the Moderator of this Community, this option is available from the Utilities menu of the Group Chat window.

The Visitors counter keeps track of the number of visitors this Community has had since it was started. Select this option to reset
the counter if you would like to track the number of participants who have joined during a particular time.






Whiteboard Controls

Note: The only way for participants' Whiteboards to be out of synchronization is if one or more people joined the Whiteboard
session after another participant had started a drawing.

The PowWow Whiteboard has controls in all four borders. Click here or the applicable area on this picture for more information.
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Drawing Tools
The Drawing Tools selectors provide the basic drawing functions. You can click on a tool icon or name for more information.

Fencil

Lirne

Brush

Fectangle

Ellipse

Teu @ Now is the time

Click one of these topics for additional information:

Color Selection
Miscellaneous Controls
Tip




Color Selection
When you click the Color Selector, a fly-out menu displays the colors from which you can choose.

Foreground Color
To select the foreground color:

1. Left-click the Color Selector.
2. Hold the mouse button and move the pointer to the desired color.
3. Release the mouse button.

Background (Fill) Color
To select the background color:

1. Right-click the Color Selector.
2. Hold the mouse button and move the pointer to the desired color.
3. Release the mouse button.



Pencil (Freehand) Tool
The Pencil tool is a free form drawing tool. To draw with the Pencil click and hold the left mouse button. You can change the width
of the pencil by clicking the Pencil Options at the bottom of the Whiteboard window.

Rry )

Click and drag to




Line Tool
The Line tool is a point-to-point drawing tool. To draw a line:

Move the cursor to where you wish to start the line.
Click and hold the left mouse button.

Move the cursor to where you wish the line to end.
Release the mouse button.
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You can change the width of the line by clicking on the Line Options at the bottom of the Whiteboard window. You also can draw a
constant stream of lines from the starting point by turning Trails on and off via the button.

Click and drag to drawe & constant strea)




Brush Tool

The Brush tool lets you draw a constant stream of brush shapes. To draw brush shapes, click the mouse button. You can create
trails by holding down the mouse button while moving the pointer. To pick a brush, click the desired shape from the Brush Options

at the bottom of the Whiteboard window.
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Brush tool for cortinuous shapes.




Rectangle Tool
Use the Rectangle tool to draw rectangular shapes. To make a rectangular shape:

1. Move the cursor to where you wish to start the shape.

2. Click and hold the mouse button.

3. Move the cursor to where you wish the shape to end.

4. Release the mouse button.

You can change the width of the frame around the shape by clicking the Shape Options at the bottom of the Whiteboard window.

To fill rectangles with the opposite color of what you are currently using click the button. You can also draw a constant stream
of rectangles from the starting point by turning Trails on and off via the

button.
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Click and drag to draswy 5 filled rectangle




Ellipse Tool

Use the Ellipse tool to draw oval and circular shapes. To make an elliptical shape:

Move the cursor to where you wish to start the shape.
Click and hold the mouse button.
Move the cursor to where you wish the shape to end.
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Release the mouse button.

You can change the width of the frame around the shape by clicking the Shape Options at the bottom of the Whiteboard window. To

fill ellipses with the opposite color of what you are currently using click the button. You can draw a constant stream of ellipses
from the starting point by turning Trails on and off via the

button.
O Cmo =
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Text Tool
Use the Text tool to add text or characters. To insert text:

1. Select the font, size, and style of text you wish to insert.
2. Position the cursor where you want to start the text and click the mouse button.
3. Begin typing.

The Backspace key erases the character to the left of the cursor.
The Enter key inserts a new line below what you have typed. You cannot change text after you have pressed the Enter key.

Note: You cannot mix fonts, styles, colors and sizes within the same text line. As soon as you click an option, the current text
entry is terminated.

[1] Now IS the iim D

Text tool for lettering and symbols.

Fill Selection
When you click the Fill button, text appears in the selected foreground color on a background of the background color.

Font Selection
When you click the Font button, this menu is displayed:

Arial
Courier Nexr
Times MNew HRoman

THngdings =

I

Move the cursor to highlight the font you want to use and release the mouse button.

Note: If you select the Wingdings symbol font, you can click the Show Key button to display a character map. This launches the
Windows CHARMAP.EXE program.

Size Selection
When you click the Size button, this menu is displayed:

Miniscule
Tiny
Xtra Small
Small
Mediwm-5Small
] Medium

Medium-Large

Large
Xtra Large
Huge
Gargantuan

Move the cursor to highlight the size you want to use and release the mouse button.

Style Selection

When you click the Style button, this menu is displayed:



Regular
Bold
Italic

|  Vnderline

Move the cursor to highlight the style you want to use and release the mouse button.



Miscellaneous Controls
These controls are located at the top and the right borders of the Whiteboard.

Help

Displays the online Help.
Minimize

Minimize the Whiteboard.

Close
Close the Whiteboard on your system. This does not affect any other people who may be participating on this Whiteboard.

Display List of Participants
Click this button to display a list of all people participating on this Whiteboard.

Size
Click and drag a corner of the Whiteboard to change its size.

Copy to Clipboard

Click to copy the entire contents of your Whiteboard display to the Windows Clipboard. From there, you can paste the bitmap into
any other applicable program.

Undo / Redo Last Action

The Undo/Redo tool allows you to remove the last item you added to the Whiteboard. If you have removed an item, clicking the
button a second time will add it back. The undo will not remove your last item if more than 15 items have been drawn since then by
other Whiteboard users. Note: This feature affects your display and the displays of all other participants.

Clear Whiteboard
The Clear tool clears the contents of the Whiteboard, using colors if you choose.

Important: This clears not only your display of the Whiteboard, but the displays of all other participants.

When you click the Clear tool, you will be asked if you wish to clear the Whiteboard:

Everything will be erased. |

Clear the “WhiteBard now?

Mo |

[T Don't warm me before clearing.

If you check Don’t warn me before clearing, you will not be prompted again to clear the Whiteboard in this session.

If you click and hold the mouse button on the Clear tool, a menu is displayed which lets you turn warn-before-clearing back on and
clear the screen using the current set of colors.

¢ Warn On Clear

Color Clearing

Color Clearing

When you activate this option and then left-click the Clear Screen button, the screen color changes to that of the foreground
color. If the background color is different, the Whiteboard screen will have a border of the background color.



If you right-click the Clear Screen button, the screen will be cleared using the background color.

If the foreground color is different,
the Whiteboard screen will have a border of the foreground color.




Tip

By holding down the Control key, you can start the drawing outside of the normal Whiteboard drawing area. Use this, for example,
to anchor a set of Trailed lines somewhere off the displayed drawing surface.

Example

This example was created the normal

This example was created using the

way: Control key and starting outside the
display area:

1. Select the Line tool.

2. Select Trails. 1. Select the Line tool.

3. Click in the upper left corner of 2. Select Trails.
the display area. 3. Press and hold the Control key.

4. Hold the mouse button and drag 4. Click in the upper left corner of
to the upper right corner. the Whiteboard border.

5. Drag diagonally to the lower left 5. Hold the mouse button and drag
corner. to the upper right corner of the

6. Release the mouse button. border.

6. Drag diagonally to the lower left
corner.

7. Release the mouse button.

8. Release the Control key.






How To ...

This list presents step-by-step procedures to perform some of the more-commonly used PowWow functions.

Important: When an option can be accessed from both the Navigator and Personal Communicator windows, the example will start
the procedure from the Navigator window.

. Request a PowWow (page someone)
o Set window colors

e Voice chat (Insta-Voice and real-time)

e  Add a Buddy to your list

o Remove yourself from someone's Buddy List
o Find someone to chat with

. Search the White Pages (for a particular user or people who share your interests)
. Enter your information into the PowWow White Pages

o Filter other users

° Play a game

. Use the Whiteboard

. Add a New User

. Hear conversations (the speech synthesizer)



Join a Community

Note: You do not have to join a Community to communicate with someone if he or she is on your Buddy List.

People join Communities to share common interests. To join a Community:

1.

2.

&

Click the * button. The Communities menu opens.

Select the Join a Community option. The PowWow Address Book opens to the Communities tab. There are three ways to
select a Community:

L]

If there already is an appropriate entry:
Select it in the list and click Join.

If there is not an appropriate entry:

But you know the Community's address (perhaps because a friend told you), type the address in the Join Community
Address field and click Join. (Note: The PowWow New Users Community often is a good place to start to become
familiar with the program. Its address is newusers@tribal.com.)

If there is not an existing entry and you do not have an address:

Click the Online Community Guide button. Your Web browser starts and goes to the Communities listing page hosted by
Tribal Voice.

First you'll see a list of general categories with brief descriptions.
1. Click a category name to go to a page listing the Communities devoted to that topic.
2. Find a listing that sounds interesting, such as:

Literature

PowWow Community: literature@tribal.com

Focus: Discussion of Literary Issues

HomePage: http://www.tribal.com

3. Click the PowWow Community address once and minimize or close your browser. The PowWow Navigator window
will show that you've now joined the selected Community:

= i 1 Fecent Logre (1]

Note that you won't see yourself as a Recent Login.



Request a PowWow (page someone)

A PowWow moves the conversation with someone to your Personal Communicator window.
To page someone who is participating in a Community or who is on your Buddy List:

1. Right-click the person's name to display the User menu.
2. Click the PowWow option. The recipient will receive a Chat Request message.

If the person selects Accept and clicks OK, a pane for the person will open in your Personal Communicator window and you
can converse directly.

Important:
You may be prompted to leave a message.
If:

. the person’s Answering Machine is on, or
. the person does not reply within 20 seconds and the Chat Request dialog times out,

The Remote Answering Machine Message dialog will be displayed.
To leave a message, enter one in the space provided and click OK.
If:

. the person selects No, or
. the person is not online,

The Send Email Message dialog is displayed.

If you would like to leave a message on the person's Answering Machine, enter one in the space provided and click OK.
If:

. the person selects No, with reason,

you will receive the person's message.

When you click OK, you’ll be able to leave an Answering Machine message.



Set Window Colors

You can change the colors which are used by your Personal Communicator window and which appear in both a Group Chat window
and someone else's Personal Communicator window.

To do this:
1. Open your Personal Communicator window if it is not already open.

Using the color selector:

T

2.  Left-click the color you want to use as your foreground color and right-click the color to use as the background. The
combination is shown to the right.

This color combination will be used by your pane (the top one) in your Personal Communicator window and in your pane in
someone else's Personal Communicator window. The foreground color will be used to display your text in a Group Chat window.

Please check the Runtime Options description of color settings in Appendix A: Preferences.



Voice Chat (Insta-Voice and real-time)
PowWow gives you two ways to talk (as opposed to typing) with someone else:

1. Insta-Voice, which lets you record a message and send it.
2. Voice Chat, which is a real two-way conversation similar to using a telephone.

(Remember that you need a sound card, a microphone and a reasonably fast connection to use the voice features.)



Insta-Voice

Because Insta-Voice is a message, you can send it to any participant in a Community or to anyone on your Buddy List who is online.
To create and send an Insta-Voice message:

1. Right-click the person's name in the Navigator window.
2. Select the Insta-Voice Message option. The Insta-Voice Message window opens.

Click the Record button (the active button to the far right) and begin speaking. The Recorder displays the volume and the
duration.

When you are finished, click the Stop (middle) button.

To hear if it was a good recording, click the Play (left) button.
To cancel the message, click Cancel.

To transmit the message, click Send.

I
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The recipient will receive a message and can Play the message, Reply to it and Delete it.



Voice Chat

Important: Voice Chat can only be done from the Personal Communicator window and only when you already have a connection
with a person.

There are three ways to start a voice conversation:
Method 1

1. Select the Utilities menu from the Personal Communicator window.

2. Select the Voice Chat option. If you have more than one person in your Personal Communicator window, you will be asked to
pick the correct person from a list.

Method 2

1. Click the Voice button on the window’s button bar E (This button is displayed only when two or more people are
connected through the Personal Communicator.) If you have more than one person in your Personal Communicator window,
you will be asked to pick the correct person from a list.

Method 3

1. Click the Voice button on the person’s button bar.
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Whichever method is used, the recipient will receive a Voice Request message.

When he or she accepts the Voice Request, the Voice Connection dialog opens on each person's computer.

Click the Help icon i for the information about the various controls.



Add a Buddy to Your List

Note: You cannot add a person to your Buddy List without his or her consent.

Method 1

The easiest way to request to add someone to your Buddy List is from an active Community in the PowWow Navigator window.

1. Right-click the person's name to open the User menu.
2. Click the Request to be a Buddy option.

. The person's name will be added to your Buddy List but will have a question mark (?) by it indicating that the person has
not consented to becoming a buddy.

. The recipient will receive a Buddy Request message.
. Once the person selects Yes and clicks OK, the question mark by his or her name will change to the standard PowWow

symbol. Now, any time the person is online (and has not marked him- or herself as Invisible or Offline), you will be
alerted.

Note: When the person selects Yes, the "Add them to my Buddy List" option becomes active. The person can send a
reciprocal Buddy Request to you by checking this box and selecting OK. You, then, would receive a Buddy Request.

Method 2

Another method to add a person to your Buddy List requires that you know the person's PowWow address. In the Navigator
window:

1. Click the Buddy List icon 4.
2. Select the Add Buddy option.

A new dialog is displayed. For information about completing the necessary fields, select the Help button.



Remove Yourself from Someone's Buddy List

Unlike some other programs, not only does PowWow let you remove someone from your Buddy List; it also lets you remove
yourself from someone else's Buddy List. To do so, in the Navigator window:

Click the Address Book icon E]'E. The Address Book will open to the Users tab.
Right-click the applicable name.

Select the Buddy Status option.

Select the Remove Yourself from ... option.
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The White Pages

Several functions take you to the White Pages at the Tribal Voice Web site. Note that these require you to have a Web browser.

To start the process from the Navigator window:

1. Click the World Wide Web icon .
2. Select the White Pages option.



Search the White Pages

Do you want to learn if someone you know is a PowWow user or do you want to find other PowWow users who share your
interests? Search the White Pages. (Note: A successful search requires that the person has entered him- or herself into the
White Pages and is currently online. While you're at it, have you entered yourself into the White Pages?)

From the World Wide Web White Pages menu:

1. Click the World Wide Web icon .
2. Select the Search the White Pages option.

Your browser will start and go to the Search the White Pages page at Tribal Voice. Fill-in the appropriate fields and click the
Search button.



Enter Your Information into the PowWow White Pages

By entering information about yourself, other PowWow users can find you by looking up your name or by searching for people
sharing common interests.

From the World Wide Web White Pages menu:

1. Click the World Wide Web icon ..
2. Select the Add Yourself to the White Pages option.

Your browser will start and go to the White Pages Add Form page at Tribal Voice. Some of the fields will be filled-in from
information you supplied when you installed PowWow. Complete the other fields and click the Add Me button.



Find Someone to Chat With

There are two popular ways to find someone to chat with. One is to use the Search the White Pages feature. The other is to look
at the list of the most recent people who have signed onto PowWow and who have registered themselves in the White Pages.

To access the list of the most recent PowWow Logins:

1. Click the World Wide Web icon L]
2. Select the Recent PowWow Logins option.
3. Select how many entries you’d like to examine.

Your Internet browser will start and go to the White Pages Search Results which lists the number of recent logins you
requested.

. To request a chat with a person, click the person’s name once and then minimize or close your browser.



Filter Other Users

The Address Book Blocking tab lets you control who is able to contact you for a PowWow. There are three modes from which you
can choose (one at a time):

1. Accept (only the people on this list can contact you)
2. Refuse (none of the people on this list can contact you)
3. None (anyone can contact you).

When you change the mode, the list changes.

To access the Blocking Book:

1. Click the Address Book icon WL,
2.  Select the Blocking Book tab.

At the bottom of the dialog, note that the default Blocking State is set to None.
To add an entry to either the Accept list or the Refuse list:

1. Click the appropriate radio button in the Current Blocking State section.
2. Click the Add button. A new dialog is displayed.

Enter a PowWow (e-mail) address, an IP address or a Domain address. This last lets you filter out page requests from
anyone using a service which may be known for its spamming activities.

To activate one of the modes:

1. Click the appropriate radio button in the Current Blocking State section. The selected mode takes effect immediately.



Play a Game

PowWow currently supports six games: Cards, Checkers, Dominoes, Chess, Backgammon and Dice. You can:

. Watch a game in progress.
. Join a game.
. Start a game.

The first step is to display the PowWow BoardGames window.
From the PowWow Navigator window:

1. Right-click a Community name.
2. Select the Games option.

From a Group Chat window:
1. Click the games button.
From a Personal Communicator window:

1. Click the Utilities menu.
2. Select the Plugins option.
3. Select Board Games.

A
1. Click the Games button on the button Bar j

Any active games and the participants will be displayed.

View

Click a game and select View to just watch the game in progress.

Join

Click a game and select Join to request to join a game in progress. The request is sent to the person who started the game.
Once he or she accepts your request, you will be brought into the game.

New
Select New to start your own game. The following Choose game dialog is displayed.

Note: When your cursor passes over an option, the representation brightens.

Select a game to start it.



Use the Whiteboard

The Whiteboard is only available from the Personal Communicator window.
Note: You do not have to be conversing with another person to use the Whiteboard and could use it as a convenient drawing tool.
To access the Whiteboard:

1. Select the Utilities menu.
2. Click the Draw option

Or

1. Click the Whiteboard button on the button bar

Click here for a description of how to use the various tools and options.



Add a New User

If several people share the same computer, you might want to create a separate PowWow account for each one. Each account will
have its own directory and settings, including Address Books and Buddy Lists.

Important: If you want each user to be able to send and receive mail, each one must have his or her own valid e-mail account.
Multiple people using different names cannot share the same e-mail address. This is a limitation of mail servers; not Pow\Wow.

To set up a new user to use PowWow:

1. Click the Configuration icon .\?
2. Select the Add New User option.

This starts the New User Wizard, with which you’re already familiar. For complete information about the various settings,
please see Appendix A: Preferences.

When multiple users are set to use PowWow, you can change the active user:

1. Click the Configuration icon \?
2. Select the Change Current User option.
3. Select the applicable entry.



Hear Conversations (the speech synthesizer)

There are many reasons why you might want to hear what people are typing. PowWow includes a speech synthesizer which you
configured when you installed PowWow (see the Text-to-Speech tab under Preferences).

The Text-to-Speech feature also translates common abbreviations used in PowWow chats. For example, "LOL" ("laughing out
loud") will be "read" by the speech synthesizer as "Hee Hee Hee."

Group Chat Window

When you’re in a Group Chat window, you can turn on Text-to-Speech so you hear all participants, or you can turn it on for selected
persons.

To turn on Text-to-Speech so everything everyone types is converted to speech:

1. Click the Hear switch.

In the PowWow Navigator window, you’ll notice that [H] is placed before each person’s name.

[ PowWow _

To turn on Text-to-Speech for selected persons:

1.  Right-click the person’s name.
2. Select the Hear option. An [H] is placed by the person’s name.

Personal Communicator Window

When you’re in the Personal Communicator window, you can turn on Text-to-Speech so you hear all participants, or you can turn it
on for selected persons.

To turn on Text-to-Speech so everything everyone types is converted to speech:

1. Click the Utilities menu.
2. Select the Hear All option. The Hear button on each participant’s button bar will be depressed.
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To turn on Text-to-Speech for selected persons:

1. Click the Hear button on the person’s button bar.
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General Tab
Use this tab to establish the basic parameters for this Community.

Community PowWow Address
This field is fixed and shows the address which was selected in the Start My Community dialog when the Community was created.
This is the address which people will enter in the PowWow Address Book Communities tab to join this Community.

Community's Name

Enter a name for this Community. This will be displayed in the PowWow Navigator list and at the top of this dialog. Note: This
functions the same as the Community's Name field on the Start My Community dialog. The Community's name can be changed
either place.

PowWow Owner Address
Enter the PowWow address of the registered owner of this Community. This address will be the same for all Communities which
are hosted by the same person. Note: This is the same as the PowWow Owner Address field on the Start My Community dialog.

Max # Users: This Community
This field is active only while this Community is running.

Important: There are three parts to your Community hosting license:

1. Number of Communities you can host
2. Total number of people who can access your Communities simultaneously
3. How long the Communities can be in operation

You can set this field to the total number of simultaneous participants your combined Communities can host. This number is
provided in the next field.

For example, if you have a license to host one Community and 50 participants, you can set this field to a maximum of 50. If you
have a license to host three Communities and a total of 150 participants, you can set this field to a maximum of 150 for each
Community being operated. However, when your combined Communities reach the total licensed number of participants, no new
people may join any Community until a participant exits.

Normally, if you host multiple Communities, you would allocate a number less than the maximum to each Community. This
allocation would avoid one Community using all your licensed participants while your other Communities could not admit anyone.

Max # Users: All Communities

While the Community is running, this field simply shows the total number of participants you are licensed to host across all the
Communities you are licensed to operate. If the Community is not running, this field indicates "Unknown." This field cannot be
changed.

Auto-Create Community
Check this option to start this Community whenever you run PowWow.



Permission Tab

Use this tab to fine-tune who is allowed to join this Community and how to automatically handle certain types of unacceptable
behavior. Your Community can be as free-wheeling or as autocratic as you like.

Auto-Accept Connections
If this option is not checked, the host must approve each request to enter the Community.

Allow Joins From
Use these two settings to determine who can join this Community. Note that if you leave both boxes unchecked, this will default to
the PowWow option.

PowWow
Check this box to allow regular PowWow users to access your Community. If only this box is checked, only users who are
running regular PowWow can join this Community. Users running Kid's PowWow will not be able to join.

Kid's PowWow
Check this box to allow users of Kid’s PowWow to access your Community. If only this box is checked, only users who are
running Kid's PowWow can join this Community. Users running regular PowWow will not be able to join.

Censor Profanity
Check this option to prevent inappropriate language in your Community. Certain words will appear with an asterisk (*) replacing
certain characters.

Disconnect Profane Users
Check this box to disconnect users who use inappropriate language. This setting is significantly less forgiving than the Censor
Profanity option. In this case, as soon as a person enters a word on the censor list, he or she is immediately disconnected.

Important: The word does not have to be a stand-alone; it can exist embedded in a word. For instance, typing Mississippi
backwards will cause the person to be disconnected.

Require Password
You might want to use this function to restrict access to known people, such as family members if the Community is for intra-family
communications, or only to members of the local model railroad club.

Check the box to require people to enter a password to access your Community. (You'll need to let people know what the
password is.) This password is the same for all users who access the Community. A user joining the Community will receive this
message:

Community Passward Enkryp

Tha commurily pou hayvs -“
aftermpled ba join |mnaﬁm

passwued lo slkow erity.
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bl

Fasmword for  petest2@hibal com
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Entry Tab

The options will determine which Community functions will be started as soon as a person joins the Community, if the functions are
enabled (refer to the Modules tab ).

Show Welcome Message
To display a short message to people entering your Community, check this box and enter your message in the field beneath it.

Auto Open Community Modules

To automatically start and display portions of your Community when people enter, check the applicable boxes here. Checking all
the boxes will tend to clutter a person's screen when he or she joins your Community. You may want to adopt a minimalist
approach.

The modules which you can open automatically are:

Chat: Check this box to open the Group Chat window. In general, you would want to open this window
automatically.

Games: Check this box to open the Games module. In general, you would not have this module open automatically.

Bulletin Board: Check this box to open the Bulletin Board. In general, you would not have this module open automatically.

GuestBook: Check this box to open the GuestBook. In general, you would not have this module open automatically.

Note: Checking the Games, Bulletin Board and GuestBook functions will have no effect unless they are enabled (see the Modules
tab).

Open URL
To automatically start a person's Internet browser and open a URL when he or she enters your Community, check this box and enter
the URL in the field beneath it. This is another option which is better if used sparingly.



Modules Tab

Use these options to enable or disable the Bulletin Board, GuestBook and Games functions in your Community. If they are not
enabled here, they will not be available to participants in the Community.

Bulletin Board
If you wish to use the Bulletin Board in your Community, check this option. You also will need to specify a directory in which
PowWow stores the message files.

The Bulletin Board lets users post and read messages of interest to the Community.
GuestBook
If you wish to use the GuestBook in your Community, check this option. You also will need to specify a directory in which PowWow

stores the signature files.

The GuestBook lets users sign it and leave a little information and read the comments other people have left. If a user finds an
interesting comment, he or she can click the PowWow Me button to page the other person.

Enable Games
If you wish to use Games in your Community, check this option.



Moderation / Administration Tab
Use this tab to designate other people who can act as moderators or administrators of this Community.

Note: Click here for a description of the automatic_Moderator's Log file.

Moderation Mode
This setting affects how a moderator's or administrator's messages are displayed.

Moderated
When a Community is in Moderated mode, the Group Chat window always displays a separate message area in which the
moderator's comments appear.

The chat window which appears on the host machine also will have a Cruise switch which the moderator can use to lead
participants on tours of the Internet.

Auto-Moderated

When a Community is in Auto-Moderated mode, the Group Chat window displays a separate message area in which the
moderator's comments appear only when the moderator types something. The text and message area are displayed until the
moderator has been idle for approximately 10 minutes.

The chat window which appears on the host machine also will have a Cruise switch.

UnModerated
When a Community is in UnModerated mode, there never is a separate moderator's message area.

Remote Administrators / Moderators
This section displays additional administrators and moderators and their current powers in the Community.

Remove
Click this button to remove the highlighted entry.

Edit
To change an administrator's or a moderator's settings, highlight the applicable name and click this button. A new dialog is
displayed. -

Add
Click this button to create additional moderators and administrators for this Community. A new dialog is displayed.

When you click the OK button at the bottom of the dialog, your community will start and will appear in the PowWow Navigator
window along with any other Communities you may have joined.



Add / Edit Administrator / Moderator

Add a Community Admsnastrabor o Moderator
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Address
Enter the PowWow address of the person being added as an Administrator or Moderator.

Powers
Check the appropriate box(es) to grant this person certain powers in the Community.

Remote Guest Moderator
This mode is intended primarily for a guest who is making a presentation. The person's text is displayed in the Moderator's
message area (if it is a Moderated or Auto-Moderated Community), but the person has no other privileges.

Remote Moderator

This person's text is displayed in the Moderator's message area (if it is a Moderated or Auto-Moderated Community) and the
person can Hang Up (disconnect) a participant and can administer the Community's Blocking Book. A Remote Moderator
cannot designate other moderators or administrators.

Also, in the PowWow Navigator display, the person is identified as a moderator by a large blue "M" next to his or her name.
Remote Administrator
This person's text is displayed in the normal message area. He or she has all powers, including designating other moderators

and administrators.

In the PowWow Navigator display, an administrator is identified by a large blue "M" next to his or her name.



Moderator's Log

A record of the actions of all remote moderators and administrators is maintained on the host computer.

Note that the host computer is whichever one started the Community. In other words, if several people co-host a Community using
multiple computers, this log will appear on each computer, although the contents will, of course, be different.

The Moderator's Log has these attributes:

. It initially is created when a remote Moderator or Administrator performs an action. Any actions performed on the hosting
system are not recorded.

. The log file is stored in the directory specified as the PowWow install directory in your WIN.INI file. This typically will be the
same location you find POWWOW32.EXE.

. It is updated automatically.
. It cannot be disabled.

. Its name is created from the Community PowWow Address plus the year and month. It has a .TXT extension. Ifa
Community's address were pwtest@tribal.com, the log file for September 1998 would be pwtest199809 log.txt. Thisisa
plain text file and may be viewed using any text editor, such as NopPad or WordPad which are provided with Windows.

. A new log is created with the first action in the month. The previous month's log is saved.

The log file's contents appear similar to:

Thu Sep 10 09:08:21 JOINED: pwtest2@tribal.com at 208.147.9.140 has joined the Community as
Administrator; Moderator;

Thu Sep 10 09:10:43 HANGUP: pwtest2@tribal.com at 208.147.9.140 hung up on
freddie@enterthedomain.com at 123.45.67.89

Thu Sep 10 09:21:42 BLOCKD: pwtest2@tribal.com at 208.147.9.140 added twit@enterthedomain.com to
Blocking Book, comment: "1, wvulgarity"

Thu Sep 10 09:25:55 BEGIN UPDATES —————————————————— - mmmmm

Thu Sep 10 09:25:55 STATUS: pwtest2@tribal.com at 208.147.9.140 - privileges for
pwtestl@tribal.com are A M

Thu Sep 10 09:25:55 STATUS: pwtest2@tribal.com at 208.147.9.140 - privileges for
pwtest2@tribal.com are A M

Thu Sep 10 09:25:55 UPDATE: pwtest2@tribal.com at 208.147.9.140 changed Auto Open Community
Modules from "" to " BBS;"

Thu Sep 10 09:25:55 UPDATE: pwtest2@tribal.com at 208.147.9.140 changed Show Welcome Message from
FALSE to TRUE

Thu Sep 10 09:25:55 UPDATE: pwtest2@tribal.com at 208.147.9.140 changed Welcome Message text from
"" to "Welcome to the PW Test Community."

Thu Sep 10 09:25:55 END UPDATES ——————————— == ———— e ———

Thu Sep 10 09:42:28 BEGIN UPDATES —-—-————————— - —— o mmmm e e e e

Thu Sep 10 09:42:28 STATUS: pwtest2@tribal.com at 208.147.9.140 - privileges for
pwtestl@tribal.com are A M

Thu Sep 10 09:42:28 STATUS:
pwtest2@tribal.com
Thu Sep 10 09:42:28

pwtest2@tribal.com at 208.

are A M G
END UPDATES

.140 - privileges for

Thu Sep 10 10:06:47 EXITED: pwtest2@tribal.com at 208.147.9.140 has exited the Community.

Note that actions which change a Community setting are listed between the BEGIN UPDATES and END UPDATES tags. A
Moderator's other actions, such as joining, exiting, hanging-up or blocking a user, are listed together.



Text-to-Speech Abbreviations

PowWow's text-to-speech converter understands certain abbreviations which you can type and which will be spoken correctly.
These abbreviations are:

A/S CHECK Age and Sex Check

AA Alcoholics Anonymous
AFAIK As Far As | Know

AFK Away From Keyboard
AFP Away From PowWow
AISB As It Should Be

AKA Also Known As

AOK AOK.

ATM At The Moment

AU Australia

AWFK AWay From Keyboard
AWK AWay from Keyboard
AZ Arizona

B/C Because

B@K Back at Keyboard

B4 Before

BAP Back at Powwow

BBBG Bye Bye Be Good
BBIAF Be Back In A Few
BBIAM Be Back In A Minute
BBL Be Back Later

BBN Bye Bye Now

BBS Bulletin Board System
BC Because

BF BoyFriend

Bl Bisexual

BLVD Boulevard

BM Blonde Moment

BML Biting My Lip

BOL Best Of Luck

BRB Be Right Back

BRBGP Be Right Back Gotta Pee
BRBH Be Right Back Helping
BRBIGGAT Be Right Back | Gotta Get A Towel
BRBIGP Be Right Back | Gotta Pee
BRH Be Right Here

BROS Brothers

BSOD Blue Screen Of Death
BTDT Been There Done That
BTG Buck Tooth Grin

BTW By The Way

BWKOL Big Wet Kiss On the Lips
BWKOTL Big Wet Kiss On The Lips
BWL Bursting With Laughter
C&G Chuckle and Grin

CA California

CALI California

CALIF California

CDT Central Daylight Time

CHP California Highway Patrol



CicO Coffee In Coffee Out

CID Crying In Disgrace

CLA Cap Lock Alert

CMON Come On

CNP Continued Next Post

CNS Computer Nerds

CcO Colorado

CO. Company

CP Chat Post

CSG Chuckle, Snicker, Grin

CST Central Standard Time

CUL Call you Later

CWYL Chat With You Later

CYA See Ya!

CYALASTR See Ya Later

D/L Download

DEL. Delaware

DGT Don't Go There

DNA Deoxyribonucleic Acid

DNK Do Not Know
DNPGDNCTHD Do Not Pass Go Do Not Collect Two Hundred Dollars
DPKOL Deep Passionate Kiss On the Lips
DR Doctor

DRT Dead Right There

DSF Dear Special Friend

DTS Don't Think So

DUW2wWB Do You Want To White Board?
DUWTWB Do You Want To White Board
DUWWB Do You Want to White Board
DWPKOTL Deep Wet Passionate Kiss On The Lips
DYw2wB Do You Want to White Board
DYWWB Do You Want to White Board
DYWTWB Do You Want To White Board
E.G. For example

EDT Eastern Daylight Time

EG Evil Grin

ELOL Evil Laughing Out Loud
EMSG Email Message

EST Eastern Standard Time

ETC ET Cetera

ETC. Et Cetera

FB Funny Business

FGT Feelin' Great Today

FL Florida

FOCL Fell Off Chair Laughing
FOOMCL Fell Out Of My Chair Laughing
FSD Fools Seldom Differ
FTBOMH From The Bottom of My Heart
FWIW For What It's Worth

FWY Freeway

FWY. Freeway

FYI For Your Information

G Grin

*g* grin



G8R
GA
GA.
GB
GD&R
GDAR
GDR
GF
GFETE
GFI
GFN
GG
GGB
GGP
GIAR
GJ
GJP
GMB
GMBO
GMC
GMC.
GMP
GMT
GMTA
GTG
GTGB
GTSU
GTSY
GW
H&K
HABO
HAGN
HAGO
HAK
HATM
HAWU
HB
HCIERY
HHB
HHIS
HI.

HP
HTY
HWY
HWY.
IE.
IANAL
IANALBIPOOTV
IANALBIPOTV
IAW
IAY
IAYT
B

Ic

Gator

Go Ahead

Georgia

Goodbye

Grinning Ducking and Running
Grinning Ducking And Running
Grinning Ducking and Running
GirlFriend

Grinning From Ear to Ear
Go For It

Gone For Now

Gotta Go

Gotta Get Beer

Gotta Go Pee

Give It A Rest

Good Job

Good Job Partner

Getting More Beer

Giggling My Butt Off
Getting More Coffee
General Motors Corporation
Getting More Pop
Greenwich Mean Time
Great Minds Think Alike
Got To Go

Got To Go Bye

Glad To See You

Glad To See You

Good Witch

Hug and Kiss

Have A Better One

Have a Good Night

Have A Good One

Hug And Kiss

Howling At The Moon

Hello All, What's Up?
Honey Bear

How Can | Ever Repay You
Hello Honey Bunny
Hanging Head In Shame
Hawaii

Home Page

Hugs To You

Highway

Highway

That s

I Am Not A Lawyer

| Am Not A Lawyer But | Play One On TV
| am Not A Lawyer But | Play One on TV
In Another Window

| Adore You

| Adore You Too

I’m Back

In Character



ICCL | Could Care Less

1.C. Integrated Circuit

ICMP Internet Control Message Protocol
IDK | Don’t Know

IDTS | Don’t Think So

IGP | Gotta Pee

IHARIMT | Have A Rumbly In My Tumbly
1S Internet Information Server
ILU | Love You

ILU2 | Love You Too

ILUL | Love You Lots

ILUT | Love You Too

ILY | Love You

ILY2 | Love You Too

ILYL I love You Lots

ILYT | Love You Too

IMHO In My Humble Opinion

IMO In My Opinion

IMY | Miss You

INC Incorporated

INC. Incorporated

IRL In Real Life

IRMC | Rest My Case

IRT In Real Time

ISP Internet Service Provider

ITB It's The Bomb

ITMOHE If The Monitor Only Had Eyes
IUSS If You Say So

IWALU | Will Always Love You

IWALY | Will Always Love You

IWMU I Will Miss You

IWMY 1 Will Miss You

IWYWH | Wish You Were Here

YD In Your Dreams

IYKWIM If You Know What | Mean
IYSS If You Say So

JIK Just Kidding

JAS Just A Sec

JB Juke Box

JCVD Jean Claude Van Damme

JJA Just Joking Around

JK Just Kidding

JMHO Just My Humble Opinion

JMO Just My Opinion

JOTL Joy Of The Lord

JTLUK Just To Let you Know

JTLYK Just To Let You Know
JTUML2K Just Thought you Might Like to Know
JTUMLTK Just Thought You Might Like To Know
JTYML2K Just Thought You Might Like to Know
JTYMLTK Just Thought You Might Like To Know
KBD Keyboard

KJV King James Version

KOC Kiss On Cheek



KOL Kiss On Lips

KOTC Kiss On The Cheek

KOTFH Kiss On The ForeHead

KOTH Kiss On The Hand

KOTL Kiss On The Lips

KTF Keep The Faith

KTLF Keeping The Lord First

L Laughing

L8 Late

L8A Latah

L8R Later

L8RS Laterz

L8RZ Laterz

LB Pound

LB. Pound

LBS Pounds

LBS. Pounds

LDT1 Let’s Ditch This One

LDTO Let’s Ditch This One

LDWPKOL Long Deep Wet Passionate Kiss On The Lips
LHM Lord Help Me

LHO Laughing Head Off

LHU Lord Help Us

LMAO Laughing My Booty Off

LMC Let Me Check

LMTAL Let Me Take A Look

LOFLOL Laying On the Floor Laughing Out Loud
LOL Hee hee hee hee

LOLRTPP Laughing Out Load Ready To Pee Pants
LOTFLOL Laying On The Floor Laughing Out Loud
LSHIAPM Laughing So Hard | Almost Peed Myself
LSHICT Laughing So Hard | Can’t Type
LSHIH Laughing So Hard It Hurts
LSHMBH Laughing So Hard My Belly Hurts
LSHMSH Laughing So Hard My Sides Hurt
LSKOL Long Slow Kiss On the Lips
LSKOTL Long Slow Kiss On The Lips

LT™M Laughing To Myself

LTMS Laughing To Myself

LTNS Long Time No See

LTS Laughing To Self

LUAC Lighting Up A Cigarette
LUWAMH Love You With all My Heart

LY Love Ya

LYLAB Love You Like A Brother

LYLAS Love You Like A Sister

LYMY Love You Miss You

LYWAMH Love You With All My Heart

M/F Male or Female

M.D. Medical Doctor

MD. Maryland

MDT Mountain Daylight Time

MFG Manufacturing

MFG. Manufacturing



MI. Michigan

MJF Michael J. Fox

MM MultiMedia

MNC Mother Nature Calls

MP Military Police

MPH Miles Per Hour

MST Mountain Standard Time
MT My Time

N2P Need to Pee

NASV New American Standard Version
NB Nutbar

NC North Carolina

NCTO Now Cut That Out

NH New Hampshire

NITB Nip It In The Bud

NIV New International Version
NJ New Jersey

NKJV New King James Version
NM New Mexico

NMH Not Much Here

NNIHAH Not Now | Have A Headache
NP No Problem

NRN No Response Necessary
NS Netscape

NSD Never Say Die

NSW New South Wales

NTFL No Time For Love

NTP Need To Pee

NU New User

NV Nevada

NW No Way

NY New York

NZ New Zealand

OB Oh Baby

oD Over Drive

oJT On The Job Training

OLL Only Laughing a Little

OMB On My Back

OMG Oh My God

(6]0) Over and Out

oocC Out Of Character

OO0TD One Of These Days

(05} Operating System

OTOH On The Other Hand
OTTOMH Off The Top Of my Head
P&W Praise and Worship

PC Personal Computer

PDQ Pretty Darn Quick

PDS Please Don’t Shout

PDT Pacific Daylight Saving Time
PEBC&K Problem Exists Between Chair & Keyboard
PEBCAK Problem Exists Between Chair And Keyboard
PEBCK Problem Exists Between Chair and Keyboard

PIC Picture



PKG
PKG.
PKOC
PKOL
PLS

PLZ
PMF
PMFJI
PML
POAHF
PPL
PSB
PSG
PST

PTL
PTLAPTA
PW

PXT

QT

RA

RAS
RBAY

R

RL

RME
RMH
ROF
ROFL
ROFLAPMP
ROFLOL
ROFUTS
ROGLOL
ROTF
ROTFL
ROTFLOL
ROTFLSTC
ROTFLSTCIIHO
ROTGLOL
RPG

RT

RYL

S

SBD
SEG
SETE
SGI
SHID
SKOTC
SMHID
SNAFU
SOl

SOL
SOP
SOS

Package

Package

Passionate Kiss On the Cheek
Passionate Kiss On the Lips

Please

Please

Problem Magically Fixed Itself

Pardon Me For Jumping In

Page Me Later

Put On A Happy Face

People

Pretty Stupid Boy

Pretty Stupid Girl

Pacific Standard Time

Praise The Lord

Praise The Lord And Pass The Ammunition
PowWow

Please Explain That

Cutie

Red Alert

Running Around Screaming

Right Back At You

Rhode Island

Real Life

Rolling My Eyes

Real Manly Hug

Rolling On the Floor

Rolling On the Floor Laughing

Rolling On the Floor Laughing And Peeing My Pants
Rolling On the Floor Laughing Out Loud
Rolling On Floor Unable To Speak

Rolling On the Ground Laughing Out Loud
Rolling On The Floor

Rolling On The Floor Laughing

Rolling On The Floor Laughing Out Loud
Rolling On The Floor Laughing Scaring The Cat
Rolling On The Floor Scaring The Cat If | Had One
Rolling On The Ground Laughing Out Loud
Role Playing Games

Real Time

Read You Later

Smile

Silent But Deadly

Seductively Evil Grin

Smiling Ear To Ear

Silicon Graphics

Slaps Head In Disgust

Soft Kiss On The Cheek

Scratching My Head In Disbelief

Situation Normal All Fouled Up

State Of Insanity

Simply Out of Luck

Standard Operating Procedure

SomeOne Special



SOT
SOTMG
SP
SPST
SSDD
STB4ID
STBID
SUITM
SUL
SUP
SUPERCA
SUS
SWAK
SWL
SYITM
SYL
SYUTH
SYWWTBY
T28
TABA
TC
THNX
THX
TIA
TIAFIMS
TIIC
TKS
TLC
TLK
TMSD
TMWF
TN

TN
TNX
TPI
TPTB
TTBOTW
TTFN
TTS
TTTT
TTYL
TTYS
TVB
TWT
X
TXS
TY
YT
UGTBK
UIN
UNT
UTFL
VA
VBG

Short Of Time

Short Of Time Must Go
Sweetie Pie

Same Place Same Time
Same Stuff Different Day
Sometime Before | Die
Sometime Before | Die
See You In The Morning
See You Later

What’s Up?
SUPERCAlifragilisticexpealidocious
See U Soon

Sealed With A Kiss
Screaming With Laughter
See You In The Morning
See You Later

Smack You Upside The Head
See Ya Wouldn’t Want To Be Ya
Text to Speech

Throws A Beer At

Take Care

Thanks

Thanks

Thanks In Advance
There Is AFly In My Soup
Those Idiots In Control
Thanks

Tender Loving Care
Tender Loving Kiss

Tiny Minds Seldom Differ
Take My Word For It
Tennessee

Tennessee

Thank you

Tuned Port Injection

The Powers That Be
Throw The ‘Bot Out The Window
Ta Ta For Now
Text-To-Speech

These Things Take Time
Talk To Ya Later

Talk To You Soon

Top Versus Bottom

Time Will Tell

Texas

Thanks

Thank You

Take Your Time

you’ve Got To Be Kidding
U.ILN

Until Next Time

Use The Force Luke
Virginia

Very Big Grin



VDPKOL Very Deep Passionate Kiss On the Lips

VDWPKOL Very Deep Wet Passionate Kiss On the Lips
VF Very Funny

VM Voice Message

W.C. Water Closet

W8 Wait

WS8ING Waiting

WAM Wait A Minute

WAYF Where Are You From

WB Welcome Back

WBRB Won’t Be Right Back

wC Water Closet

WEG Wicked Evil Grin

WFHC What For How Come

WFR Waiting For Reply

WMPLOL Wet My Pants Laughing Out Loud
WP Word Perfect

WPKOL Wet Passionate Kiss On the Lips
WSDMU We Sure Did Miss you

WTB Where’s The Beef

WTG Way To Go

WTH What The Heck

WTV Watching TV

wucC Why You Cry

WUWT What's Up With That?

WWA Waiting With Anticipation
WWJD What Would Jesus Do
www World Wide Web

WWYC Write When You Can

WY Wyoming

WwYC Why You Cry

WYM What You Mean

WYSIWYG What You See Is What You Get
XFER Transfer

XING Crossing

XMAS Christmas

X0 Hugs and Kisses

XTRA EXTRA

YBIC Your Brother in Christ

YBS You’ll Be Sorry

YG Young Gentleman

YGB You Go Boy

YGBKM You Gotta Be Kidding Me
YGG You Go Girl

YGTBK You Got To Be Kidding

YIAH Yes | Am Here

YL Young Lady

YLYSC You’re Lucky You’re So Cute
YM Young Man

YSIC Your Sister in Christ

YT Yours Truly

YW You’re Welcome

YYSSW Yeah Yeah Sure Sure Whatever

YYSSLIBTO Yeah Yeah Sure Sure Like | Believe That One









